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Abstract 
 
 
 

Learner-controlled e-learning has become a preferred medium for the delivery of 

organizational training. While e-learning offers organizations and trainees many 

advantages, it also comes with several potential disadvantages. The aim of this study was 

to explore the relative efficacy of learner- and program-controlled e-learning for content 

that differs in its complexity. This study also explored cognitive load as a differential 

mediator of the interaction between learner control and training content complexity for 

predicting cognitive and behavioral learning outcomes. Finally, learning goal orientation 

was explored as a motivational individual difference that helps learners cope with 

complex, learner-controlled e-learning environments. Results suggest that while there is 

little difference between learners in learner- and program-controlled e-learning 

environments for content that is relatively simple in nature, complex, learner-controlled 

e-learning environments are detrimental to cognitive learning relative to complex, 

program-controlled environments. Moreover, the results suggest that this interaction is 

differentially mediated by cognitive load, suggesting that complex, learner-controlled 

environments induce high cognitive demands onto learners which ultimately inhibit 

cognitive learning. Finally, learning goal orientation was identified as more facilitative 

individual difference in learner-controlled e-learning environments relative to program-

controlled and simple training environments. Theoretical and practical implications of 

these findings are also discussed.



 
 

 

 
 
 

Introduction 
 

Given the increasing popularity of electronic learning media (e-learning) in 

organizational and educational settings (Sugrue & Rivera, 2005), it is becoming 

increasingly important for research to keep pace with its practice. It is evident that, for 

better or worse “e-learning is undoubtedly here to stay” (Spector, 2008, p. 193). The 

dramatic increase in the use of electronic technology to deliver training has been dubbed 

the “e-Learning Revolution” (Galagan, 2000, p. 25), but training researchers have not 

been uniformly enthusiastic. A key characteristic of e-learning that has garnered a great 

deal of attention is learner control. Although not uniformly the case, e-learning usually 

grants learners high levels of control over the learning environment (Bell & Kozlowski, 

2002; DeRouin, Fritzsche, & Salas, 2004; Ely, Sitzmann, & Falkiewicz, 2009). While 

learner control is indeed a key component of e-learning, the issues surrounding learner 

control clearly apply to training content delivered via other modalities. However its role 

in e-learning has been a focus of much of the recent research on e-learning and thus, that 

modality of training content delivery is emphasized here. Regardless of the means of 

delivery however, much is still unknown about which learners benefit from high levels of 

learner control, which do not, when it works and why.  

In general, training researchers have investigated situational and contextual 

factors that influence training effectiveness (Narayan & Steele-Johnson, 2007) such as 

organizational climate and career planning (Colquitt et al., 2000) and supervisory support 

(Mathieu & Martineau, 1997). More recent work has uncovered a variety of core training 
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design factors that lead to enhanced learning and transfer in learner-controlled training 

environments. For example, Bell and Kozlowski (2008) found that exploratory learning 

and manipulations to encourage making errors during training have positive effects on 

trainees’ adaptive transfer. Training research has also focused on the interrelationships 

among various individual difference variables and training outcomes (e.g., Blume, Ford, 

Baldwin, & Huang, 2010; Brown, 2005; Brown, 2001; Ely et al., 2009; Fisher & Ford, 

1998; Ford, Smith, Weissbein, Gully, & Salas, 1998; Schmidt & Ford, 2003; Sitzmann, 

Bell, Kraiger, & Kanar, 2009). The extant research has confirmed that while certain 

interventions may be beneficial for some trainees, they are not necessarily beneficial for 

others. This research has been extended to learner-controlled e-learning environments 

(e.g., Brown, 2001; Fisher, Wasserman, & Orvis, 2010; Schmidt & Ford, 2003; Sitzmann 

et al., 2009), but additional research is needed to confirm many of the propositions and 

assumptions often made about e-learning and arguably its most important feature: learner 

control (Granger & Levine, 2010). 

E-learning is linked to a number of different approaches to training and learning 

such as active learning (Bell & Kozlowski, 2008), hypermedia learning (Scheiter & 

Gerjets, 2007), distributed learning (Kraiger & Jerden, 2007) and self-directed learning 

(SDL) (Lee & Lee, 2008). Despite their distinctions, one of the hallmarks of active 

learning media, such as e-learning, is learner control. In learner-controlled training 

environments, learners are active participants in the learning process (Frese & Altmann, 

1989; Salas & Cannon-Bowers, 2001) and are responsible for regulating their own 

learning (Bell & Kozlowski, 2008). As pointed out by Lee and Lee (2008) this approach 

to learning is supported by the constructivist educational philosophy which focuses on 

2 
 



 
 

how the learner builds an understanding of the world through exploration and interaction 

with the environment (Rovai, 2004). From this perspective, a learner’s active 

participation in training is clearly viewed as advantageous. Despite the exciting potential 

of learner control and the fact that it is often considered an advantage of e-learning or 

active learning media (Kinzie & Sullivan, 1989), a growing body of empirical work 

suggests that many adult learners do not effectively utilize the high levels of control 

afforded to them in e-learning (e.g., Bell & Kozlowski, 2002; Brown, 2001). And while 

some research has been devoted to understanding which learners benefit from learner-

controlled e-learning and which do not (e.g., Brown, 2001; Schmidt & Ford, 2003), much 

has yet to be examined.  

Nevertheless, the research on learner-controlled training has predominantly 

focused on contextual and interpersonal factors that influence learning and post-training 

performance. Relatively less research has focused on aspects of the training content itself. 

One key characteristic of the training content that is not well understood in the context of 

e-learning is its intrinsic complexity. Recently, Granger and Levine (2009) found that the 

intrinsic complexity of the content being trained is an important determinant of the 

effectiveness of learner-controlled training environments. Their study raises questions 

about the appropriateness of delivering complex training content to trainees via learner-

controlled e-learning. To my knowledge, this is the only study of this important 

relationship in the e-learning literature and more research is needed to better understand 

this relationship and provide guidance to training practitioners and organizations for the 

delivery of training content via e-learning. As such, this dissertation addresses several 

gaps in the literature regarding the role of training content complexity in e-learning as 
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well as a key motivational individual difference (learning goal orientation) that may help 

some trainees cope with complex training content in learner-controlled e-learning 

environments.  

Study Objectives  

The primary aim of this dissertation is to increase our understanding of how 

training content complexity affects the relationship between learner control and learning 

outcomes. Much of the research on the efficacy of learner-controlled e-learning is in 

disagreement (Kraiger & Jerden, 2007) which implies the existence of potentially many 

intervening variables. As an important factor from both a practical (Liff & Kraiger, 2007; 

Welsh et al., 2003) and theoretical perspective (Granger & Levine, 2010), I expect the 

degree of training content complexity to serve as an important boundary condition of the 

effectiveness of granting trainees high v. low levels of learner control in e-learning.  

Specifically, the intrinsic complexity of the training content is expected to moderate the 

learner control-learning relationship in the proposed study, such that a high degree of 

learner control will be detrimental to learning when the content of training is complex. 

On the other hand, the degree of learner control granted to trainees is expected to have 

less of an effect on learning when the content of training is relatively simple.  

A question immediately arises as to why this occurs. Thus a second aim of this 

dissertation is to explore a potential factor, cognitive load, as a mechanism through which 

content complexity interacts with learner control to influence learning. Specifically, 

complex, learner-controlled training environments are expected to induce a high level of 

cognitive load in trainees that is detrimental to learning and thus explain why learning is 

impaired in such environments.  
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Third, answering Granger and Levine’s (2010) call for additional research on 

individual differences that may potentially counter the negative combined effect of high 

levels of learner control and content complexity, this dissertation explores learning goal 

orientation (LGO) as a trainee characteristic that may predict success (failure) in such 

training environments. The benefit of a high level of learning goal orientation is 

hypothesized due to its well-known association with important meta-cognitive strategies 

(Ames, 1992; Church, Elliot, & Gable, 2001; Dweck, 1986; Chiaburu, Van Dam, & 

Hutchins, 2010; Fisher & Ford, 1998; Towler & Dipboye, 2001) which are particularly 

important for learning complex training material in self-paced learning environments 

(Schmidt & Ford, 2003). Trainees with high levels of learning goal orientation are 

expected to more effectively handle complex training material when presented with a 

high degree of learner control than those with low levels of learning goal orientation. 

That is, high LGO trainees are expected to manage high levels of cognitive load produced 

by learner-controlled, complex training environments more effectively than low LGO 

trainees, because of their use of important metacognitive strategies throughout training.  

The final objective of this dissertation is to empirically test whether increased 

metacognitive strategies explain why high LGO learners may more effectively handle 

learner-controlled, complex training environments than low LGO learners. An 

understanding of which learners flourish in complex, learner-controlled training 

environments is indeed important, but an understanding of why this may be the case is 

also important from both a practical and theoretical perspective. Similar to Schmidt and 

Ford (2003), I expect metacognition to mediate the relationship between LGO and 

learning such that high LGO trainees are expected to acquire more declarative and 
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procedural knowledge and effectively perform trained skills post-training than low LGO 

trainees in learner-controlled complex training environments due to their use of important 

metacognitive strategies during training.  

In the following section, I define e-learning, my operational definition of learner 

control, establish the link between the two concepts and provide a brief overview of the 

research supporting and opposing their effectiveness. Next is the presentation of training 

content complexity as a potential moderator of the objective learner control-learning 

outcomes relations. I then present a discussion of relevant research on aptitude-treatment 

interactions (ATIs) in the general training literature as well as the presentation of learning 

goal orientation which, when high, is expected to predispose certain trainees to success 

under conditions of high learner control and high content complexity.  A review of the 

current study including the presentation of cognitive load theory (CLT) and formal 

hypotheses concludes the introduction. A discussion of the study methodology, results 

and discussion of the findings concludes the dissertation. 

Learner Control and e-Learning 

According to Eddy and Tannenbaum (2003), e-learning refers to training 

initiatives for which content, communication and learning material are provided to 

learners via the use of electronic technology. Today, e-learning is often accomplished via 

computers (Clark & Mayer, 2007) and so computer based e-learning will be the primary 

focus of this study. As indicated above, numerous researchers have pointed to the 

importance of learner control in e-learning contexts (Brown, 2005; DeRouin, Fritzsche, & 

Salas, 2005; Fisher et al., 2010; Granger & Levine, 2010; Kraiger & Jerden, 2007; Orvis, 

Brusso, Wasserman, & Fisher, 2011; Orvis et al., 2009). Training programs that involve 
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high levels of learner control typically give trainees control over a variety of aspects such 

as timing, pacing, and selection of training content (Friend & Cole, 1990; Scheiter & 

Gerjets, 2007). Because of this, it is important to clarify what is meant by learner control 

in the current study. In research and practice, learner control usually comes as a “package 

deal”, meaning that learner-controlled e-learning grants trainees control over several 

aspects of training simultaneously (See Fisher et al., 2010; Orvis et al., 2011; Orvis et al., 

2009 and Sitzmann et al., 2009 for typical examples). This is often done out of necessity 

because it is difficult to disentangle control over many of these aspects (e.g., time spent in 

training and pacing) and control over one’s learning environment is often considered 

advantageous in practice (Kinzie & Sullivan, 1989; Long & Smith, 2004). In order to 

increase the external validity of the current investigation, learner control will henceforth 

refer to control over pacing, sequencing of training content/modules, the amount of time 

spent on the course as well as individual portions of the course, and the training content 

that is covered or skipped. Importantly, while there are many other aspects of learner 

control, each of the aforementioned aspects can be considered internal aspects of control 

that have the potential to affect trainees’ exposure to the training content itself. Moreover, 

these aspects of control are often included in manipulations of learner control in the 

extant literature (e.g., Granger & Levine, 2009; Orvis et al., 2009; Sitzmann et al., 2009). 

This study does not address aspects of external or contextual learner control such as 

control over the location of training, the time of day trainees engage in training, etc. 

Unlike internal learner control, these aspects of learner control are not expected to 

directly impact trainees’ exposure to the actual training content. 
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In addition to the distinction between internal and external learner control, 

Kraiger and Jerden (2007) have argued for the distinction between objective and 

subjective learner control. While subjective learner control refers to the extent to which 

learners perceive that they have control over their learning, objective learner control 

refers to the actual degree of control afforded to them. Though they are distinct, they are 

indeed expected to covary positively (Liff & Kraiger, 2007; Kraiger & Jerden, 2007). 

This dissertation focuses on the effects of objective learner control as it is expected to 

precede and largely determine trainees’ perceptions of the degree of their learner control 

(Kraiger & Jerden, 2007).  

When describing active learning or learner-controlled approaches to training, it is 

common for researchers to compare and contrast them with more traditional, presumably 

passive learning approaches (Bell & Kozlowski, 2008) or program-controlled approaches 

(Hannafin, 1984). While learner control allows learners to make choices about numerous 

aspects of their learning, program control does not. These distinctions are useful because 

they highlight the uniqueness of active learning approaches along with their advantages 

(or presumed advantages). In more traditional approaches to training (e.g., instructor-led 

classroom instruction) the learner may be described as a passive participant in training or 

perhaps more accurately, a participant with little discretion in choosing training content, 

pacing, sequencing, media, etc., throughout the learning process. In such contexts, the 

flow of training content is primarily from teacher/trainer to student/trainee. By contrast, 

trainees assume a central role with expanded discretion and more involvement in the 

communication of training content when training environments are deemed learner-

controlled (Brown & Ford, 2002).  
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According to learning theories such as the constructivist approach, active learning 

or learner-controlled approaches to training should lead to enhanced learning outcomes 

(Lee & Lee, 2008). For example, Bell and Kozlowski (2008) note that active learning 

approaches promote inductive learning which allows for learner experimentation and 

exploration. Additionally, Kraiger (2008) has argued that web based training (WBT) or e-

learning technologies allow for third-generation learning which is based on the social 

constructivist approach to learning. That is, according to Kraiger (2008) and the social 

constructivist approach, learning is primarily a social activity which depends heavily on 

interactions among trainees and other trainees and among trainers and trainees. 

Nevertheless, empirical research on learner-controlled e-learning has not been uniformly 

supportive of the propositions and assumptions made about its effectiveness (Granger & 

Levine, 2010). 

Although it is often taken for granted, it is important to note that many of the 

primary advantages of e-learning apparently necessitate some degree of learner control 

and a great deal of the extant research on learner control and e-learning questions their 

proposed and assumed advantages (Granger & Levine, 2010). To cite one notable 

example, while Kraiger (2008) has argued that e-learning technology allows for enhanced 

interaction among trainees and trainers, other researchers have argued that e-learning may 

not always facilitate positive communications among training participants (e.g., Brown & 

Klein, 2008; Sitzmann & Ely, 2008). In fact, empirical evidence suggests that 

asynchronous, e-learning environments foster less or more difficult communication 

among training participants (Gilbert, Morton, & Rowley, 2007; Hara & Kling, 2001; 

Rovai & Barnum, 2003) contrary to Kraiger’s (2008) contention.  
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Much like the training media research in general (e.g., Sitzmann et al., 2006), the 

research on learner-controlled e-learning has yielded mixed results regarding its 

effectiveness. While some research suggests that learner control leads to favorable 

learning outcomes (Avner, Moore, & Smith, 1980; Gray, 1987; Kinzie, Sullivan, & 

Bendel, 1988) other research has found that program-controlled or passive learning 

approaches are more effective for facilitating learning (Lee & Wong, 1989; Levinson, 

Weaver, Garside, McGinn, & Norman, 2007; MacGregor, 1988; Steinberg, 1977; 

Morrison, Ross, & Baldwin, 1992). In addition to the contradictory findings for learning, 

some of the research on learner control suggests that learners tend to react more favorably 

to training environments characterized by high levels of learner control (Becker & 

Dwyer, 1994; Hintze, Mohr, & Wenzel, 1988; Milheim, 1989; Morrison, et al., 1992; 

Orvis et al., 2009) while meta-analytic evidence suggests that there is little support for the 

notion that learner control is meaningfully related to trainee affective reactions (Kraiger 

& Jerden, 2007).  

Despite some contradictory findings, the wealth of research that has explored the 

efficacy of learner-controlled e-learning may lead one to expect that learner control is 

uniformly, albeit slightly advantageous to learners. Indeed some researchers have pointed 

to the potential and empirically-derived benefits of granting learners high levels of 

control during training (e.g., Kinzie & Sullivan, 1989; Orvis et al., 2009).  Negative 

outcomes that have clouded the picture may be attributable to the problem that some 

trainees do not effectively utilize learner control (Kraiger, 2008; Steinberg, 1989; 

Tennyson, Christenson, & Park, 1985) and discontinue their involvement in training prior 

to mastery (Brown, 2001; Schmidt & Ford, 2003). This may account for Kraiger and 
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Jerden’s (2007) meta-analytic findings, suggesting only a slight advantage for learner-

controlled environments versus those characterized as program-controlled. Nevertheless, 

despite the lack of substantial superiority, organizations and educational institutions are 

implementing e-learning technologies at a staggering pace and are incorporating an 

unprecedented amount of control for learners over their learning environment (Bell & 

Kozlowski, 2002; Welsh et al., 2003). 

 Because of the increased reliance on learner-controlled e-learning in 

organizational and educational settings and the mixed findings regarding its 

effectiveness, it is important for researchers to continue investigating the relative 

effectiveness of high versus low learner-controlled training environments. While some 

learning theories support the use of active learning and learner control (e.g., the 

constructivist approach; Rovai, 2004), much of the empirical work suggests that many 

trainees do not effectively utilize the control afforded to them and consequently impair 

their learning of the training content (Bell & Kozlowski, 2002; Brown, 2001; Schmidt & 

Ford, 2003). Clearly, research does not support the unbridled adoption of e-learning 

paired with high levels of learner control (Granger & Levine, 2010). More research is 

needed to establish conditions for effective outcomes when these approaches are used. As 

discussed above, this dissertation attempts to clarify the relationship between learner-

controlled e-learning and learning outcomes by exploring training content complexity as 

a key moderator of this important yet equivocal relationship.  

Training Content Complexity 

A key issue that has only very recently been explored in the learner control 

literature is the potential moderating role of training content complexity on the 
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relationship between the degree of objective learner control and cognitive and skill-based 

learning. While practitioners (Welsh et al., 2003) and researchers (e.g., Liff & Kraiger, 

2007) have expressed concerns about granting high levels of learner control to trainees in 

complex training environments (e.g., presentation of complex training content), there has 

been very little research investigating this issue. Recently, Granger and Levine (2009) 

directly tested this relationship and found that the intrinsic complexity of the training 

content is indeed an important moderator of the learner control-learning relationship. 

Specifically, they found that while there were no significant differences between trainees 

in low v. high learner control conditions for the training of relatively simple content, high 

levels of learner control were detrimental to declarative and procedural knowledge 

acquisition when the training content was complex in nature.  

Consistent with cognitive load theory (CLT), the framework used by Granger and 

Levine (2009) to operationally define training content complexity, the manipulation of 

the complexity of the training content in this study involves increasing the number of 

distinct bits of information that must be processed by learners (Van Merrienboer & 

Ayres, 2005) during a training session. Importantly, an increase in the number of 

elements one must attend to during training inevitably increases the interconnectivity of 

the elements. In order to learn the material and successfully accomplish a complex 

learning objective, learners must process many elements and their interrelationships in 

working memory (Van Merrienboer, Kester, & Paas, 2006).  

As is evident in much of the research on learner-controlled e-learning, many 

trainees make poor decisions that inhibit their learning during learner-controlled training 

and this may be especially problematic when the training content is complex in nature 
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(Bell & Kozlowski, 2002; Granger & Levine, 2009; Liff & Kraiger, 2007). However, in 

their investigation of the interaction between objective learner control and training 

content complexity, Granger and Levine’s (2009) operationalization of learner control 

confounded the presence of the instructor with the degree of control afforded to trainees. 

That is, the “high learner control” and “low learner control” conditions were 

operationalized as learner-controlled computer-based training v. instructor-controlled 

classroom instruction respectively. This dissertation provides an additional test of this 

important interaction by disentangling the potential influence of instructor presence and 

the extent of objective learner control, while keeping the internal dimensions of control 

granted to trainees consistent (i.e., pacing, sequencing of material, the amount of time one 

spends in training and on various training modules, and the content that trainees choose 

to attend to and/or skip) and practically relevant.  

Another issue that has yet to be uncovered is why the intrinsic complexity of the 

training content may moderate the relationship between the degree of learner control and 

learning outcomes. Granger and Levine (2009) found limited support for time-on-task as 

a mediator of this relationship, suggesting that the reduced time-on-task that is typical for 

trainees in learner-controlled (v. program-controlled) training environments (Kulik & 

Kulik, 1991) only partially explained why trainees acquired more declarative knowledge 

in program-controlled environments for the training of complex material. They speculate 

that other mediators, such as the degree of cognitive load experienced by learners in these 

training environments, may explain why trainees acquired more declarative and 

procedural knowledge in a program-controlled complex training environment than those 

in a learner-controlled complex training environment.   
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In demonstrating that the intrinsic complexity of the training content is an 

important moderator of the relationship between learner control and training outcomes, 

Granger and Levine’s (2009) findings suggest that some trainees performed quite well on 

the post-training measures of learning in the “high learner control-complex” condition. 

That is, some trainees were able to effectively handle the high degree of learner control 

afforded to them under complex training conditions. As is implied by the results in 

support of moderation, many trainees did quite poorly under these conditions as well. 

Thus, it is important to identify individual differences that predispose trainees to success 

(and failure) in such conditions to help guide the practice of granting trainees high v. low 

levels of learner control in e-learning (Granger & Levine, 2010).  

Individual Differences in Trainability 

In addition to uncovering various contextual factors (Colquitt et al., 2000; 

Mathieu & Martineau, 1997) and design elements (Bell & Kozlowski, 2008) that 

influence training outcomes, training researchers have identified individual differences 

that lead some trainees to learn and transfer their skills more effectively than others (e.g., 

Brown, 2001; Fisher & Ford, 1998; Orvis, et al., 2009; Schmidt & Ford, 2003; Sitzmann 

et al., 2009). The notion of trainability, in general, refers to the ability of certain 

individuals to benefit from training interventions (Noe, 2008) and there is a substantial 

body of research directed at investigating individual differences in trainability. Among 

the many individual differences that predict the trainability of learners, research has 

identified cognitive ability (Blume et al., 2010; Colquitt et al., 2000; Ree & Earles, 1991; 

Ree et al., 1995), self-efficacy (Sitzmann et al., 2009), certain personality characteristics 

(Blume, et al., 2010; Colquitt et al., 2000) and goal orientation (Brett & VandeWalle, 
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1999; Brown, 2001; Ely et al., 2009; Orvis et al., 2009) as important predictors of 

learning outcomes that predispose trainees to success in various training environments.  

Regarding learner-controlled e-learning specifically, there is evidence that certain 

individual differences lead trainees to utilize learner control more effectively than others 

(e.g., Brown, 2001; Orvis et al., 2009; Schmidt & Ford, 2003). This is consistent with 

Saks and Haccoun’s (2008) general notion that different trainees may benefit from 

different instructional methods. Research on aptitude-treatment interactions (ATIs) 

suggests that learners react quite differently to the same or similar learning environments 

(Snow, 1992). According to Cronbach and Snow (1977), an aptitude refers to an 

individual characteristic that influences the probability that a learner will benefit from a 

certain treatment. A treatment, on the other hand, typically refers to the various 

instructional techniques that are expected to influence learning outcomes (Snow, 1991).  

Empirical evidence suggests that many learners are poor judges of their own 

learning (Koriat & Bjork, 2005) and utilize poor learning strategies (Bjork, 1994; Kraiger 

& Jerden, 2007) especially in learner-controlled e-learning. Based on this evidence 

trainees do not appear to be universally equipped to effectively regulate their own 

learning. As a result Kraiger (2008) for one has stated that, “more control and more 

responsibility assigned to learners is not necessarily a good thing” (pp. 505). Kraiger’s 

(2008) commentary on active learning approaches to training suggests a number of 

avenues for researchers to pursue, among them identifying individual differences that 

interact with learner control to influence training outcomes. As with the training research 

in general, it is important to identify trainee characteristics that interact with certain 
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conditions that are presented by the various training media for clearly one size does not 

fit all when it comes to e-learning.  

Overall, past research has pointed to the importance of several variables that may 

affect the success of training. Among the potential myriad of individual differences that 

may interact with the degree of learner control and training outcomes, this dissertation 

explores learning goal orientation because of its link to important metacognitive/ self-

regulatory strategies (Ames, 1992; Chiaburu et al., 2010; Church et al., 2001; Dweck, 

1986; Ford et al., 1998; Mesmer-Magnus & Viswesvaran, 2007; Schmidt & Ford, 2003) 

and the likelihood that high levels of learning goal orientation will thus predispose 

trainees to effectively manage high levels of cognitive load (Granger & Levine, 2010). 

Additionally, from a practical perspective, evidence from the training literature suggests 

that a learning goal orientation can be induced to some extent (Button et al., 1996) and be 

positively influenced by external factors that can in turn be influenced by trainers, 

instructional designers, supervisors, etc. (Chiaburu et al., 2010; Heckhausen & Kuhl, 

1985; Kozlowski & Bell, 2006), thus making it an individual difference that can be 

influenced prior to and during training.  

As mentioned above, understanding why high LGO learners may more effectively 

handle high levels of cognitive load produced by complex, learner-controlled 

environments is also important. An understanding of this relationship will help guide 

organizations, trainers and instructional designers to deliver training material more 

effectively by embedding or including specific self-regulatory prompts (e.g., Sitzmann & 

Ely, 2010; Sitzmann et al., 2009) and/or inducing states prior to and during training that 

lead to more effective management of challenging training environments and ultimately 
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better learning. The link between LGO and metacognitive activity (e.g., Church et al., 

2001; Ford et al., 1998; Mesmer-Magnus & Viswesvaran, 2007; Schmidt & Ford, 2003) 

is expected to help high LGO learners handle high levels of cognitive load and effectively 

learn the training content under complex training conditions. 

 In summary, a high learning goal orientation is hypothesized to serve as a 

facilitating individual characteristic that helps trainees succeed in complex, learner-

controlled e-learning environments. The intrinsic complexity of the training content is 

expected to present trainees with increased cognitive load which high LGO learners are 

expected to handle more effectively than low LGO learners through the use of effective 

metacognitive strategies during training. A low LGO is expected to place learners at a 

critical disadvantage when presented with complex training content in a learner-

controlled e-learning environment primarily because of reduced metacognitive activity in 

the face of high cognitive load.  
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The Current Study 

 
The primary objective of this study is to further clarify the moderating role of 

training content complexity on the relationship between objective learner control and 

several important training outcomes. This study builds on the research of Granger and 

Levine (2009) by isolating the degree of learner control1 and content complexity as the 

key independent variables as well as a mediator of this relationship, cognitive load. In 

using cognitive load theory (CLT) as a framework for the conceptualization and 

manipulation of content complexity, cognitive load is expected to explain the proposed 

moderation between learner control and content complexity for predicting learning 

outcomes. Learning goal orientation (LGO) is then presented as a facilitating individual 

difference that is expected to help some learners handle complex, learner-controlled e-

learning environments through the application of important meta-cognitive strategies. A 

model linking the focal variables in this study is presented in Figure 1. The figure 

illustrates that the interaction between objective learner control and training content 

complexity will be mediated by cognitive load for predicting learning outcomes. It 

further illustrates that the hypothesized interaction between objective learner control and 

content complexity will be moderated by learning goal orientation for predicting learning 

outcomes, and that learning goal orientation’s impact on learning outcomes will be 

                                                 
1 As discussed above, Granger and Levine’s (2009) operationalization of learner control 

confounded the degree of objective control granted to trainees with the presence (absence) of an instructor. 
In other words, learner control was further operationalized as the presence vs. absence of an instructor who 
guided the training course in the low learner control condition.  
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mediated by metacognition. The next section specifically addresses the various training 

outcomes that will be measured in this study and a description of CLT. 
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Figure 1. Summary of Hypothesized Relationships among the Focal Variables 

 
 
 

Training Outcomes 

When the efficacy of instructional approaches or training media is discussed, it is 

important to distinguish among the relevant training outcomes. One of the most popular 

training evaluation taxonomies was developed by Kirkpatrick (1976). In his original 

taxonomy, it was suggested that training programs should be evaluated on four distinct, 

yet related outcomes. Specifically, Kirkpatrick’s (1976) taxonomy includes trainee 

reactions (Kirkpatrick, 1959) (i.e. are trainees satisfied with training?), learning of the 
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material (i.e. do trainees learn what is being taught?), demonstration of the behaviors 

taught (i.e. can trainees engage in the specific behaviors being trained, how easily do 

trainees perform the behaviors, and what is their capacity to perform in other contexts?), 

and organization-level outcomes or results. Although it was originally suggested that the 

outcomes were hierarchically organized such that lower level outcomes (trainee 

reactions) must be sufficiently positive for subsequent outcomes to occur, conceptual 

(e.g., Alliger & Janak, 1989) and meta-analytic (e.g., Arthur et al., 2003; Sitzmann et al., 

2008) work highlight a number of problems with this notion.  

 More recently, training researchers have offered more nuanced conceptualizations 

of training outcomes (e.g., Alliger, Tannenbaum, Bennett, Traver, & Shotland, 1997; 

Kraiger, Ford, & Salas, 1993). For instance, while training researchers and practitioners 

have at times treated learning and affective outcomes each as unidimensional, they are 

now known to be multidimensional (Brown, 2005; Kraiger et al., 1993). Regarding non-

affective training outcomes, Kraiger et al. (1993) explicitly pointed out the distinction 

between declarative and procedural knowledge. Unfortunately, measures of declarative 

knowledge are often the only learning measures used to evaluate the effectiveness of 

training (if any learning measures are used at all). In fact, one recent meta-analysis 

comparing web-based to traditional classroom media (Sitzmann et al., 2006) only tested 

moderators for declarative knowledge due to the small number of studies measuring 

procedural knowledge. To address these issues in how the effectiveness of training has 

been assessed in past research, the current study utilizes multiple measures of learning 

(declarative knowledge, procedural knowledge, and skill-based procedural knowledge).  
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 In distinguishing declarative and procedural knowledge, Kraiger et al. (1993) 

define declarative knowledge as knowledge of facts and principles and the relationships 

among relevant elements. In contrast, they define procedural knowledge as knowledge of 

how to perform a skill or carry out a process. Traditionally, declarative knowledge has 

been measured with recall tests such as multiple choice examinations that measure 

learners’ ability to recall facts and principles that are covered in a training course. While 

less frequently measured in the training literature and in practice, procedural knowledge 

has been measured in two general ways: learners demonstrate that they recall the steps 

that must be taken to carry out a set of actions or learners actually demonstrate the skills 

being trained. The relevance of both measurements to the construct of procedural 

knowledge is supported by Sitzmann et al.’s (2006) meta-analysis which coded both 

approaches as measures of procedural knowledge. Both measurements of procedural 

knowledge are included in this study. Throughout the remainder of this paper, I refer to 

the latter of these approaches as skill-based procedural knowledge.  

Cognitive Load Theory 

 Given its importance for the operationalization of intrinsic content complexity and 

its role as a key mediator in this study, a brief review of cognitive load theory (CLT) is 

presented. As a theory, CLT is focused on the human cognitive architecture (Cierniak, 

Scheiter, & Gerjets, 2008) and is based on the fundamental notions that the human 

working memory is limited in its storage capacity and its ability to process new 

information (Baddeley, 1992; Miller, 1956) while long term memory is nearly limitless in 

the amount of information that can be stored (Krischner, 2002). In CLT, working 

memory is considered a bottleneck to learning such that any information that passes to 
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long-term memory must first be processed in working memory (Gerjets & Scheiter, 

2003). CLT distinguishes among sources of cognitive load that impact learners’ limited 

working memory resources: intrinsic, extrinsic, and germane cognitive load (Sweller, 

2005). These sources of cognitive load play a part in the overall cognitive load or mental 

effort experienced by the learner during training.  

Intrinsic cognitive load. According to CLT, intrinsic cognitive load is directly 

influenced by the complexity of the training content itself. For example, manipulations of 

the intrinsic cognitive load of learning content include increasing the number of elements 

and the interconnectivity among those elements that must be processed by the learner in 

working memory (Mayer, 2008; Van Merrienboer, Kester, & Paas, 2006). Overall, it has 

been suggested that intrinsic cognitive load is determined both by the interactivity of the 

learning elements and the expertise of the individual learner (Sweller et al., 1998). As 

learners become more experienced with the training content, they develop schemas that 

link the interconnected portions of the learned material (Ayers & van Gog, 2009). This 

then helps learners overcome the known limitations of working memory. For instance, 

the same learning material can be processed as many distinct elements by novice learners 

or as a few chunks of information by experienced learners (Chi, Glaser, & Rees, 1982; 

Van Merrienboer et al., 2006).  

Extraneous cognitive load. While intrinsic cognitive load is directly influenced by 

the complexity or intrinsic difficulty of the actual training content, extraneous cognitive 

load refers to load placed on learners which is irrelevant to the content being learned. 

While instructional designers and trainers may be able to reduce the intrinsic complexity 

of the training content, the tenets of CLT suggest that instructional design techniques 
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likely have more impact over the extraneous cognitive load experienced by learners 

(Krischner, 2002). Instructional design features such as the degree of learner control, 

communication tools, simultaneous audio and video, etc. can and do influence extraneous 

cognitive load which ultimately reduces working memory space (Bannert, 2002). 

Similarly, Mayer (2008) suggests that one of the ultimate purposes of instructional design 

is to reduce extraneous processing, which he defines as “cognitive processing that wastes 

precious cognitive capacity but does not help the learner build an appropriate cognitive 

representation” (pp. 763). Indeed, work in CLT suggests that providing full control to 

learners may impose high levels of extraneous cognitive load (Scheiter & Gerjets, 2007) 

and research from other fields suggests that granting trainees full control over their 

learning is often detrimental to learning (Bell & Kozlowski, 2002; Brown, 2001; Kraiger, 

2008) as it may place unduly high levels of (extraneous) cognitive load onto learners 

(Granger & Levine, 2010). As a simple example, if learners are given high levels of 

control of a computerized learning task, but are relatively unfamiliar with computers, 

then cognitive resources are devoted to using the computer as opposed to learning the 

focal content (Eveland & Dunwoody, 2001).  

Germane cognitive load. In addition to intrinsic and extraneous cognitive load, 

proponents of CLT point to a third source of cognitive load known as germane cognitive 

load. Unlike intrinsic and extraneous cognitive load which consume valuable cognitive 

resources, germane cognitive load is expected to enhance learning. Specifically, germane 

cognitive load occurs when portions of unused working memory are actively devoted to 

instructional activities such as attending to the training material, setting goals, etc. From 

an instructional design perspective, increasing germane cognitive load often involves 
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directing learners’ attention toward relevant (germane) aspects of the training material. 

For example, in a series of studies, Sitzmann and colleagues (Sitzmann & Ely, 2010; 

Sitzmann et al., 2009) presented trainees with self-regulatory and self-evaluative prompts 

during training. The purpose of these prompts was to direct trainees’ attention and effort 

toward the training content and ultimately improve their learning of the material. Such 

interventions increase the germane cognitive load experienced by learners, by directing 

unused cognitive resources toward understanding the content of the training course. 

While I argue that complex, learner-controlled training environments lead learners to 

experience greater intrinsic and extraneous cognitive load, germane cognitive load is not 

expected to result from either of these conditions. Thus, in this study, I operationalize 

cognitive load as the degree of intrinsic and extraneous cognitive load (or detrimental 

cognitive load) experienced by learners throughout training.  

Moderating Role of Training Content Complexity 

 Although practitioners (Welsh et al., 2003) and researchers (e.g., Granger & 

Levine, 2010; Liff & Kraiger, 2007) have argued for the importance of considering the 

complexity of the content being trained in e-learning, to my knowledge, there has only 

been one empirical investigation on this issue. In their study, Granger and Levine (2009) 

found that the intrinsic complexity of the training material was a significant moderator of 

the relationship between the degree of learner control and cognitive and skill-based 

learning outcomes, such that a high degree of learner control is detrimental to declarative 

and procedural knowledge acquisition when the content of the training is relatively 

complex. The degree of learner control afforded to trainees had no effect on learning 

when the content of training was simple in nature. As called for by Granger and Levine 
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(2010), this dissertation attempts to replicate these findings, explore cognitive load as the 

mechanism through which this interaction is expected to impact learning and investigate 

learning goal orientation as a potential facilitator countering the potentially negative 

effects of high learner control in complex training environments. 

As previously stated, one of the primary purposes of e-learning is to allow 

trainees to control their own learning. In learner-controlled e-learning courses, trainees 

often spend less time on course-related activities than trainees in program-controlled 

training environments (Brown, 2001; Kulik & Kulik, 1991) and given the known 

disadvantages of high degrees of learner control, learners are expected to face increasing 

difficulty in utilizing high degrees of learner control when in complex training 

environments (Bell & Kozlowski, 2002; Granger & Levine, 2009). That is, one reason 

why the intrinsic complexity of the training content may moderate the relationship 

between the extent of objective learner control and cognitive and skill-based learning 

outcomes is due to decreased time-on-task characteristic of trainees in learner-controlled 

training courses (Brown, 2001; Freitag & Sullivan, 1995) which should be especially 

detrimental to trainees presented with complex material. Granger & Levine (2009) 

directly tested this hypothesis and found that time-on-task partially mediated the 

relationship between the degree of learner control and declarative knowledge only when 

the content of training was intrinsically complex in nature2. Time-on-task was not found 

to mediate the relationship between the degree of learner control and procedural and 

skill-based procedural knowledge for either complex or simple content. Thus, there are 

                                                 
2 Time-on-task, which was operationalized as the total amount of minutes trainees spent on 

course-related activities, including training modules and practice opportunities, did not mediate the 
relationship between the degree of learner control and any learning outcome when the content of training 
was simple in nature.  
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likely other reasons why training content complexity moderates the relationship between 

the degree of learner control and learning. One such possibility is the degree of cognitive 

load experienced by learners in these training environments (Granger & Levine, 2010).   

According to CLT, complex information places a heavier burden on learners’ 

working memory by requiring learners to attend to more unique elements and their 

interconnectivities simultaneously (Van Merrienboer et al., 2006). In other words, the 

content of two training courses differs in complexity to the extent that one presents more 

unique elements to be processed by learners. By increasing the number of elements that 

learners must attend to, the interconnectivity among those elements increases 

exponentially. The conceptualization of complexity in CLT is very similar to that of 

Wood (1986) who suggests that a manipulation of several complexity components (i.e., 

component complexity, coordinative complexity, and dynamic complexity) basically 

involves increasing the number of distinct bits of information that must be processed by 

the learner. 

According to CLT, complex material places a high degree of intrinsic cognitive 

load onto learners and contributes to the overall cognitive load or mental effort 

experienced by learners (Ayers & van Gog, 2009). Alone, a high degree of intrinsic 

cognitive load (content complexity) places a heavy burden on trainees’ working memory 

space. High degrees of learner control should present trainees with high levels of 

extraneous cognitive load (Scheiter & Gerjets, 2007), which again, is irrelevant to the 

content being learned but ultimately works to reduce the cognitive resources available for 

learning the training content (Bannert, 2002; Mayer, 2008). Thus, learner-controlled 

training environments are expected to be increasingly problematic when the intrinsic 
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complexity of the training content is high. The difference between high and low levels of 

learner control may be less dramatic when the content of training is simple in nature due 

to the reduced levels of cognitive load experienced by learners. This reasoning leads to 

the first two hypotheses to be tested in this study: 

Hypothesis 1: Training content complexity will moderate the relationship between 

the extent of learner control and (a) declarative knowledge, (b) procedural knowledge, 

and (c) skill-based procedural knowledge. Outcomes will be poorer in the high learner 

control condition compared to the low when complexity is high, whereas the differences 

will not be as substantial when complexity is low. 

Hypothesis 2: The moderated relationship between training content complexity 

and (a) declarative knowledge, (b) procedural knowledge, and (c) skill-based procedural 

knowledge will be differentially mediated by cognitive load such that trainees in 

complex, high learner-controlled environments will learn less than trainees learning 

simple content and with less control over their training environment due to increased 

cognitive load. 

Individual Differences and Cognitive Load 

 Although much of the extant research utilizing CLT as a framework has focused 

on the effects of various instructional design elements that reduce or eliminate extraneous 

cognitive load, consideration of both intrinsic and extraneous cognitive load lead me to 

believe that certain individual differences predispose some learners to success and failure 

in learner-controlled e-learning environments. Given e-learning’s ability to adapt to the 

individual needs of learners (Cascio & Aguinis, 2005; Long & Smith, 2004), it is 

important to uncover individual differences that influence training outcomes in e-learning 
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environments (Granger & Levine, 2010; Kraiger, 2008). In the next section, I argue that 

above and beyond the learner’s cognitive ability and experience with the specific training 

content, a high degree of learning goal orientation will help some learners manage high 

levels of cognitive load introduced by learner-controlled, complex training environments. 

Moreover, I argue that a reason why high LGO learners may handle these training 

environments is their willingness and ability to engage in important metacognitive 

strategies that facilitate learning. 

Goal Orientation 

Although the motivational construct of goal orientation (GO) originated in the 

education literature (Dweck, 1975; Nicholls, 1975), GO has received substantial attention 

in the organizational literature in recent years (Payne, Youngcourt, & Beaubien, 2007). 

Because GO was conceived of independently by several researchers, there is still no 

consensus as to the specific nature of the construct. However, it is well recognized that 

GO is a motivational variable that influences how individuals approach and respond to 

learning/achievement tasks (Dweck & Leggett, 1998). According to DeShon and 

Gillespie (2005), the most common approaches to defining GO include viewing GO as 

the adoption and pursuit of achievement goals (e.g. Elliot, 1999; Ellliot & Church, 1997; 

Elliot & Harackiewicz, 2001), treating GO as a trait or individual difference variable that 

is responsible for certain differences in behavior (e.g. VandeWalle, 1997; VandeWalle, 

Cron, & Slocum, 2001; Phillips & Gully, 1997) and treating GO as somewhat 

dispositional, but allowing for modification based on certain situational characteristics 

(e.g. Button, Mathieu, & Zajac, 1996; Mangos & Steele-Johnson, 2001). Similar to 
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Dweck and Leggett’s (1988) definition, DeShon & Gillespie (2005) treat GO as a pattern 

of actions that are undertaken by an individual in order to pursue goals.  

Dimensionality of Goal Orientation  

In addition to the definitional inconsistencies present in the extant literature, there 

has been debate as to the dimensionality of GO. Originally, GO was conceived of as 

lying along a continuum from performance orientation to learning orientation. That is, it 

was originally believed that individuals could not possess both a performance and 

learning goal orientation concurrently (Dweck, 1986). A learning goal orientation (LGO) 

refers to a tendency to develop competence through increasing one’s ability and learning 

to master challenging situations (Brett & VandeWalle, 1999; VandeWalle et al., 2001; 

Dweck & Leggett, 1988) while a performance goal orientation (PGO) refers to a 

tendency to seek competence in order to validate oneself to others (VandeWalle et al., 

2001). This eventually changed however, as researchers now believe that it is possible to 

have multiple goal orientations (Dweck, 1989; Buttons et al., 1996). Later, Elliot and 

colleagues and VandeWalle and colleagues suggested further dividing PGO into 

performance-prove (PPGO) and performance-avoid (PAGO) tendencies. While PPGO is 

quite similar to the original conceptualization of PGO, PAGO refers to a tendency to 

maintain competence in order to avoid negative judgments by others (VandeWalle et al., 

2001).The most recent meta-analysis in the literature focused primarily on this three-

dimensional treatment of GO since it is the most widely researched (Payne et al., 2007) 

and well supported (VandeWalle, 1997; Button, et. al., 1996; Deshon & Gillespie, 2005). 

This conceptualization of GO is thus adopted in this study.   
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Again, the most common treatment of GO in the literature suggests that there are 

three orthogonal goal orientations that can be adopted by individuals. LGO has long been 

touted as the most favorable of the GO types due to its positive relationships with many 

favorable outcomes in work and educational settings (Payne et al., 2007). The two PGOs 

have often been cast in a negative light due to their less favorable relationships with 

important performance-related criteria, although PAGO is likely the primary driver of the 

negative effects found for PGO (Payne et al., 2007). As the most consistent predictor of 

metacognitive activity (e.g., Church et al., 2001; Ford et al., 1998; Mesmer-Magnus & 

Viswesvaran, 2007; Schmidt & Ford, 2003) and learning outcomes in educational and 

workplace settings (Brown, 2001; Ely, et al., 2009; Payne et al., 2007; Schmidt & Ford, 

2003), this study focuses solely on LGO.  

Learning Goal Orientation, Metacognition and Learning Outcomes 

 Metacognition refers to a person’s awareness of and control over her own 

thoughts (Dinsmore, Alexander, & Loughlin, 2008; Flavell, 1979). Importantly, 

metacognition is an effortful process (Efklides, 2011) that some learners are willing to 

engage in and others are not. The behaviors associated with metacognition are often 

categorized into two general types of activities: monitoring and control activities. As 

discussed in more detail below, high LGO learners are expected to engage in a number of 

monitoring and control activities that will ultimately help them handle complex, learner-

controlled training environments. 

In addition to the empirical findings in support of the positive relationship 

between LGO and learning outcomes (e.g., Brown, 2001; Ely, et al., 2009; Payne et al., 

2007;Schmidt & Ford, 2003), LGO is expected to impact how trainees experience 
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cognitive load due to differences in metacognition. For instance, by definition, high LGO 

learners attend more to the learning material than those lower in LGO and engage in less 

off-task attention (Brown, 2001). As pointed out by Brown (2001), cognitive effort plays 

a vital role in determining learning as it is well known that learners who engage in more 

on-task attention (characteristics of learners who are high in LGO) during training 

outperform those who focus their attention to things that are irrelevant to learning content 

at hand (Fisher & Ford, 1998; Kanfer & Ackerman, 1989). In CLT terms, learners high in 

LGO decrease their off-task attention and ultimately attend more to the learning material 

at hand and thus experience decreased extraneous cognitive load. High LGO learners also 

accomplish this by carefully monitoring their learning and controlling their allocation of 

resources during training (Ford et al., 1998; Metcalfe & Shimamura, 1994; Nelson & 

Narens, 1990; Schmidt & Ford, 2003). Specifically, high LGO learners engage in 

activities such as planning their approach to a learning task, continuously monitoring 

their progress throughout training, prioritizing learning tasks according to their learning 

needs and using this information to allocate resources accordingly (Ford et al., 1998; 

Schmidt & Ford, 2003; Nelson & Narens, 1990), thus suggesting that metacognitive 

strategies mediate the effects of goal orientation on learning outcomes (Payne et al., 

2007; Sitzmann & Ely, 2011). Such activities are expected to help learners overcome the 

high levels of cognitive load introduced by complex, learner-controlled training 

environments.   

Additionally, unlike much of the research on individual differences and 

performance in learner-controlled e-learning environments (e.g., Brown, 2001; Schmidt 

& Ford, 2003) this study explicitly compares two training courses that differ in the degree 
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of objective learner control granted to learners. Learner controlled e-learning requires 

trainees to regulate their effort during training (Bell & Kozlowski, 2008; Brown, 2001) 

and thus researchers have pointed to the importance of studying individual differences in 

self-paced learning environments (Ely et al., 2009; Kraiger, 2008). The notion of 

situational strength is also relevant here as learner-controlled e-learning environments 

generally represent weaker situations than program-controlled courses. In weak 

situations, individual differences are more likely to be expressed and thus influence 

outcomes (Mischel & Peake, 1982). In program-controlled training environments, 

situational cues such as the presence of instructions and pre-determined timeframes may 

restrict the expression of individual differences such as LGO. Thus, the effect of LGO is 

expected to be greater in high learner control environments v. those that offer little or no 

learner control. While LGO may have little impact on outcomes in program-controlled 

training environments, these effects are expected to be much greater in a learner-

controlled environments with fewer situational cues and more room for the expression of 

motivational individual differences. Similar to Kraiger and Jerden (2007), I predict that 

trainees high in LGO will benefit more than those low in LGO from a high degree of 

learner control. 

 As discussed at length above, high levels of LGO are associated with increased 

meta-cognitive activity (Payne et al., 2007; Schmidt & Ford, 2003; Sitmann & Ely, 2011; 

Sitzmann & Ely, 2010). Using CLT as a framework, I reason that the increase in 

metacognitive activity (e.g., on-task attention, focused effort, self-monitoring, effective 

allocation of resources) that is characteristic of learners high in LGO will help facilitate 

trainees’ efforts to counter the proposed negative effects of increased cognitive load in a 
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complex, learner-controlled training environment and lead to more beneficial learning 

outcomes. Additionally, while high levels of LGO may indeed be beneficial to trainees’ 

learning when presented with relatively simple training content, their facilitating effect is 

expected to be more dramatic in complex e-learning environments. A similar pattern is 

expected for high v. low degrees of learner control, such that the facilitating effect of 

high levels of LGO is likely to be more dramatic in the learner-controlled e-learning 

environment (v. program-controlled) due to the increase in extraneous information that 

must be attended to by learning in the learner-controlled condition and the “weakness” of 

the condition which should allow for the expression of motivational individual 

differences. The hypothesized three-way interaction between learner control, content 

complexity and LGO, stated formally below as Hypothesis 3, reflects this rationale. 

Additionally, increased metacognitive activity is expected to mediate the relationship 

between LGO and learning outcomes and thus help explain why high LGO learners better 

handle complex training environments. This reasoning undergirds Hypothesis 4.   

Hypothesis 3: The hypothesized interaction between the degree of objective 

learner control and training content complexity in influencing the degree of (a) 

declarative knowledge, (b) procedural knowledge, and (c) skill-based procedural 

knowledge will be further moderated by the extent to which learners are high v. low in 

LGO; such that trainees high in LGO will benefit more from a high degree of learner 

control when presented with complex training content compared to those low in LGO and 

the difference in learning outcomes between trainees high and low in LGO will be 

greatest in the high learner control/complex training content condition. 
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Hypothesis 4: Metacognition will mediate the relationship between LGO and (a) 

declarative knowledge, (b) procedural knowledge, and (c) skill-based procedural 

knowledge such that high LGO learners will experience greater metacognitive activity 

during training than low LGO learners. 
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Study Design 
 

 In this study, the focal manipulations are those of objective learner control and 

training content complexity. Similar to past manipulations of learner control in the 

literature (e.g., Orvis et al., 2011; Orvis et al., 2009), study participants were randomly 

assigned to one of two possible learner control conditions: high v. low control. Although 

low levels of learner control are typically characteristic of system or program-controlled 

training environments such as traditional classroom training, the aim of this dissertation 

is to isolate internal learner control as the variable manipulated. E-learning technology is 

advancing quickly and although e-learning is typically accompanied by high degrees of 

learner control (DeRouin et al., 2005), this is not uniformly the case (Granger & Levine, 

2010). Thus, in this study, I compared high and low learner control in an e-learning 

environment similar to that done by Orvis and colleagues (Orvis et al., 2011; Orvis et al., 

2009). This, again, is in contrast to the approach used by Granger and Levine (2009) who 

manipulated learner control by comparing a self-administered web-based training course 

to an instructor-delivered classroom training course. The training course itself consisted 

of a multimedia Power Point 2007 training tutorial designed to instruct trainees on the use 

of the software package. Additionally, CLT guided the manipulation of training content 

complexity, creating two complexity conditions (simple v. complex). A fully crossed 

design was implemented such that trainees were randomly assigned to one of four 

conditions: high learner control-complex, low learner control-complex, high learner 

control-simple and low learner control-simple.  
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Objective Learner Control 

To bolster the generalizability of the manipulation of objective learner control in 

this study, learner control is operationally defined as the extent to which trainees have 

control over (1) the pacing, (2) the sequencing, (3) the amount of time spent on the course 

as well as various portions of the course, and (4) the content they choose to cover or skip. 

Trainees in the high learner control condition were explicitly instructed to pace their 

learning of the material as they see fit, allocate as much time as is necessary for each 

training module, skip any content in the training that they feel they do not need to cover 

and go through the training modules in whatever order they choose. Trainees in the low 

learner control condition were presented with the same content but were instructed to 

follow along with the pre-created visual presentation and pre-determined time frames for 

each training module. Finally, while the actual PowerPoint presentation used to deliver 

training material allowed for a high degree of learner control in the high control 

condition, the course used in the low control condition did not (e.g., course contained pre-

set timing for each PowerPoint page in the tutorial). For simplicity, the high learner 

control and low learner control conditions will henceforth be referred to as the learner 

controlled (LC) and program controlled (PC) conditions respectively.  

Training Content Complexity 

The manipulation of training content complexity involved varying the number of 

distinct bits of information that must be processed by learners in the training course. This 

manipulation is consistent with the tenets of CLT which suggest that a learning task 

becomes more complex as the number of elements that must be attended to 

simultaneously by learners is increased (Van Merrienboer & Ayres, 2005). Perhaps most 
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importantly, however, increasing the number of elements that must be attended to by 

learners dramatically increases the interconnectivities among the elements which 

ultimately increase the intrinsic complexity of the training content and should lead to an 

increase in the intrinsic cognitive load experienced by learners. Specifically, the 

manipulation of training content complexity in this study is similar to that of Granger and 

Levine (2009) such that the complex training condition requires trainees to learn 

operations in PowerPoint 2007 that are more advanced and require a more sophisticated 

understanding of PowerPoint than the simple training condition. For example, learners in 

the complex condition are required to learn the same skills taught in the simple condition 

in addition to several more advanced functions, without the benefit of much more time (at 

least in the PC condition since trainees are given control over this aspect in the LC 

condition).  

 A pilot study was conducted in advance of the main study for several reasons. 

These included ensuring the effectiveness of the key manipulations, the appropriateness 

of the measures and the appropriateness of all study protocols and procedures.  A brief 

summary of its results follows. 
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Pilot Study 
 

 Despite evidence for the content complexity manipulation used in the study (see 

Granger & Levine, 2009) and the similarity of the learner control manipulation with other 

such manipulations in the e-learning literature (i.e., Orvis et al., 2009) a full trial of the 

study was piloted. A total of 50 undergraduate students signed up for the study through 

the online experiment recruitment website. Students were randomly assigned to one of 

four conditions: LC-complex (n = 15), PC-complex (n = 12), LC-simple (n = 10) and PC-

simple (n = 13). 

 First, to ensure the effectiveness of the learner control protocols and 

manipulation, I conducted an independent samples t-test comparing the two learner 

control conditions on perceptions of learner control. As expected, results suggest that the 

trainees in the LC condition (M = 4.53, SD = .40) perceived having significantly more 

learner control than trainees in the PC condition (M = 1.49, SD = .89), t(48) = -15.62, p 

<.0001. Second, to ensure the effectiveness of the complexity protocols and 

manipulation, I conducted an independent samples t-test comparing the two complexity 

conditions on the perceived complexity measure. As anticipated, results suggest that the 

trainees in the complex condition (M = 2.28, SD = .64) perceived the training content to 

be significantly more complex than trainees in the simple condition (M = 1.25, SD = .49), 

t(48) = -6.24, p < .0001. Based on the results described above and observations that the 

protocols and materials were operating as expected, no changes were made to the 

protocols or study materials.  
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Main Study 

 
Participants 

 Study participants consisted of 308 undergraduate students, virtually all 

psychology majors at a large university in the southeastern United States. Students 

registered for the study through an online experiment recruitment website. Participants 

received extra credit in exchange for their participation in the study. An a priori power 

analysis was conducted using G*Power 3.1.2 (Faul, Erdfelder, Lang, & Buchner, 2007) 

and the estimated total sample size for a three way interaction for a small to medium 

effect size (Cohen, 1988) with alpha set at .05 and power at .80 was 308 (N = 77 

participants per cell). Of the 308 cases, nine were removed from the analyses due to 

having missing data for all survey items. Two additional cases were removed for having 

impossible values for several survey items and aberrant responding to many of the survey 

items. Thus, data for a total of 297 participants were included in the analyses. Upon 

signing up for the study, individuals were randomly assigned to one of four conditions: 

LC-Complex (n = 74), PC-Complex (n = 76), LC-Simple (n = 76) and PC-Simple (n = 

71).   

The demographics of the sample are as follows: The sample consisted of 79.5% 

females; the average age was 20.89 years (SD = 3.85); their races/ethnicities were 

reported as being either White (58.2%), Black or African American (17.2%), Hispanic or 

Latino (14.5%), Asian (9.8%), or American Indian or Native Alaskan (.3%), and their 
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levels in college were reported as being either a freshman (31%), sophomore (19.5%), 

junior (16.5%), senior (31.6%) or other (1.3%). 

Independent Variables and Manipulation Checks 

 Perceived learner control. Though not identical, objective and perceived learner 

control are expected to covary positively (Kraiger & Jerden, 2007). Using an adaptation 

of the scale developed by Granger and Levine (2009) and similar to that used by Park and 

Kraiger (2005) to assess trainees overall perceptions of the degree of learner control, 

trainees were asked to what extent they perceived that they have control over the various 

dimensions of control granted to them in the e-learning course. Trainees responded to the 

items on a 5 point Likert scale ranging from Strongly Disagree to Strongly Agree 

(Appendix A). An example item includes: “Overall, I was in control of the time I spent 

learning the material in the training course”. The measure showed excellent internal 

consistency (α = .96). 

 Perceived content complexity. The degree to which learners perceived that the 

training content is complex in nature was measured and used to assess whether the 

manipulation of objective content complexity was successful. Though objective 

complexity and perceptions of the complexity of the training content are distinct 

constructs (Campbell, 1988), they are expected to covary positively. A measure 

developed by Granger and Levine (2009) was used in this study, which asks trainees to 

rate the extent to which they perceive the training content to be complex in nature using a 

5 point Likert type, five item scale ranging from Strongly Disagree to Strongly Agree 

(Appendix B). An example item includes: “Overall I thought that the training course was 

difficult”. The measure showed good internal consistency (α = .75). 
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Potential Control Variables 

 PowerPoint familiarity. Because prior experience with the training content is 

expected to covary with the post-course measures of learning, a measure of trainees’ self-

reported familiarity with PowerPoint was used in order to control for its potential effects 

on learning outcomes. This 12 item scale required participants to rate their familiarity 

with several specific operations common to PowerPoint on a five point scale ranging 

from Extremely Unfamiliar to Extremely Familiar (Appendix C). Each of the 12 

operations included in the scale were covered in the complex version of the training 

course3. Example items include “Opening a blank PowerPoint presentation” and 

“Including Footers into a PowerPoint presentation”. The measure showed very good 

internal consistency (α = .86). 

Cognitive ability. As is common in the e-learning literature (e.g., Fisher et al., 

2010; Orvis et al., 2009; Sitzmann et al., 2009) a measure of cognitive ability was used to 

control for its effects on learning outcomes. Specifically, participants were asked to self-

report their highest composite ACT or SAT (Verbal + Quantitative) scores4. Participants 

who were unsure of their exact scores, were asked to estimate them to the best of their 

knowledge (Appendix D). Participant ACT and SAT scores were then placed on the same 

scale by transforming them to z-scores, using national data reported by the respective 

testing companies. Research by Koenig, Frey & Detterman (2008) and Frey and 

Detterman (2004) has shown that both the ACT and SAT have large general mental 

ability components and correlate highly with other common measures of cognitive 

                                                 
3 Due to the complexity manipulation, some but not all of the operations listed in the PowerPoint 

familiarity measure were covered in the Simple version of the training course.  
 
4 Research by Cassady (2001) suggests that college student self reports of scholastic achievement 

(e.g., GPA, SAT scores) are very highly correlated with actual scores.  
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ability. Moreover, ACT scores, as well as SAT scores, are often used as measures of 

cognitive ability for college admissions decisions (Stark, Chernyshenko, & Drasgow, 

2004).  

Individual Difference Measures 

 Learning goal orientation. Learning goal orientation (LGO) was measured using 

a variation of Elliot and Church’s (1997) state GO measure. Because the focus of this 

study is on trainees’ goal orientation in a specific training setting, the items were tailored 

to the PowerPoint training course. The LGO measure included six items measured on a 

five point Likert scale ranging from Strongly Disagree to Strongly Agree. An example 

item includes “I want to learn as much as possible from this course”. The measure 

showed very good internal consistency (α = .89). 

 Metacognitive activity. The specific metacognitive strategies used by trainees 

during training were measured using Schmidt and Ford’s (2003) 15 item measure of 

metacognitive activity which is adapted from Ford et al.’s (1998) scale. An example item 

includes “During this training program, I carefully selected what to focus on to improve 

on weaknesses I identified”. Trainees responded to these items on a five point scale 

ranging from Almost Never to Almost Always. The measured showed excellent internal 

consistency (α = .93). 

Dependent Measures 

 Cognitive load. The degree of cognitive load experienced by trainees in the 

various training courses was measured with an adaptation of Cierniak, Scheiter, and 

Gerjet’s (2009)5 subjective measures of extraneous and intrinsic cognitive load. Because 

                                                 
5 Ayers and van Gog (2009) note that this approach to the measurement of cognitive load has been 

more supportive of the tenets of cognitive load than split-attention/ dual-task methodologies.  
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both dimensions of cognitive load are expected to unfavorably influence trainees’ 

cognitive resources during training and the hypothesis regarding mediation of the 

moderated relationship between the degree of learner control and content complexity, 

these dimensions were combined to represent a single measure of detrimental cognitive 

load. Participants responded to these two items on a six point Likert-type scale with 

responses ranging from Not at all to Extremely. The measure showed very good internal 

consistency (α = .82). 

Declarative and procedural knowledge. Upon completion of the training course, 

participants completed a 20 item multiple choice exam (Appendix E). Trainees were 

required to close out the training course while taking the post-course examination and 

were explicitly instructed to “treat it like an actual college level examination”. Each 

question included four possible options. Ten of the questions on the final exam measured 

declarative knowledge by requiring trainees to demonstrate an understanding of the 

different definitions and concepts associated with PowerPoint (e.g., Which of the 

following options best describes the purpose of the Ribbon within PowerPoint?). The 

additional 10 questions measured procedural knowledge by requiring participants to have 

an understanding of the steps required for the successful completion of certain tasks 

common to PowerPoint (e.g., Which of the following is the correct sequence for using the 

Ribbon to insert pictures into your slideshow?). The final examinations for all conditions 

were identical. However, it was expected that trainees in the complex condition, who 

received training on more advanced PowerPoint functions, would perform better than 

trainees in the simple conditions. Since this represents a potential confound, declarative 

and procedural knowledge gain were operationalized as the percentages of relevant 
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questions answered correctly. For example, the complex courses prepared trainees for all 

20 questions in the examination. Thus, their total percentages for declarative and 

procedural knowledge were calculated by summing the number of correct answers and 

dividing this number by 10 (for each learning measure). On the other hand, only 11 of the 

20 questions were covered in the simple condition. Thus, for participants in the simple 

condition, total percentages were calculated by summing the number of correct answers 

to the relevant questions and dividing the total number of relevant questions. The internal 

consistency estimates of the declarative and procedural knowledge sub-sections of the 

exam were quite low (KR-20 = .37 and .49 for declarative and procedural knowledge 

respectively). Because trainees in the simple condition were not trained on some of the 

operations covered by several items in the exam, I analyzed the internal consistency of 

the measures for trainees in the simple and complex conditions separately. For trainees in 

the simple condition, the internal consistency of the declarative and procedural measures 

was .46 and .50 respectively. For trainees in the complex condition, the internal 

consistency of the declarative and procedural measures was .40 and .52 respectively. 

Overall, only a very minor improvement was observed when calculated separately for the 

simple and complex conditions. Additionally, item-analysis and item deletion based on 

item-total correlations and the internal consistency when items are deleted was explored, 

but no meaningful increase in reliability was observed. Thus, I determined that there was 

little value in removing items from the declarative and procedural knowledge measures. 

Overall cognitive learning. Due to the low reliabilities observed for the individual 

learning measures, I combined the measures into an overall cognitive learning measure to 

improve the reliability of the learning outcome and thus potentially increase the 
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likelihood of detecting important relationships with cognitive learning6. Similar to the 

operationalization of declarative and procedural knowledge, scores for overall cognitive 

learning were calculated separately for trainees in the complex and simple conditions. As 

such, the total percentages of the cognitive learning measure were calculated by summing 

the number of correct answers to relevant questions and dividing by the total number of 

relevant questions. As expected, the internal consistency improved considerably once the 

two measures were combined (KR-20 = .61).  

 Skill-based procedural knowledge. A skill-based procedural knowledge task 

similar to that used by Granger and Levine (2009) was used to measure the effectiveness 

with which trainees demonstrated their learning of the training content. Specifically, 

participants were instructed to create a 3 slide, PowerPoint presentation from scratch. A 

limited number of parameters were provided to trainees (as may be the case in a real 

educational or organizational setting) and trainees were instructed to use the skills that 

they learned in the training course to successfully complete the task. Participants were 

instructed to create a presentation on how to prepare for a college-level examination 

(Appendix F). The effectiveness of the participants’ PowerPoint presentations was 

assessed independently by three trained research assistants. The research assistants 

consisted of two female and one male, white/ Caucasian undergraduate students. Each of 

the raters was put through a one hour frame of reference training in which raters first 

completed the complex version of the training course to orient them to the content. Raters 

were then given the complex and simple training scripts as well as short lists of the 

operations/ skills taught in each version of the training course. Finally they were oriented 

                                                 
6 As is shown in the Results, the correlation between the two learning measures was positive and 

strong in magnitude (r = .48, p < .0001) further supporting the combination of the measures into an overall 
cognitive learning measure. 
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to the rating key. Following the training, raters scored each presentation from the simple 

condition7, using a five point, anchored rating key ranging from Very Poor to Excellent 

(Appendix G). Once raters completed their ratings for the simple condition, they then 

provided ratings for the complex condition. It is important to note that raters were 

specifically instructed to rate presentations based on the skills demonstrated by the 

creator as opposed to the actual content of the presentation. The presentations’ quality, 

measuring the degree of skill-based procedural knowledge gained during training, was 

indexed as the sum of the three raters’ scores. Inter rater reliability was estimated by 

averaging the inter rater correlations and then applying the Spearman-Brown correction 

to the average r. The resulting reliability coefficient was .92.  

Additional Measures 

Motivation to learn.  While not a focal variable in this study, I included a 

variation of Noe and Schmitt’s (1986) eight item motivation to learn scale. One of the 

potential limitations of the use of an all-student sample is that the results may not 

generalize to employees completing job-relevant training, partially because there may 

important motivational differences between students completing training for extra credit 

and employees taking training to enhance their job-relevant knowledge and skills. Thus, I 

included Noe & Schmitt’s (1986) pre-training motivation to learn measure to offer insight 

into this potential limitation. Item wording was tailored slightly to the PowerPoint 

training course. Two of the original scale items were removed (e.g., “The reason I 

decided to participate in this course was to learn how I can improve my PowerPoint 

                                                 
7 Because the skills taught in the simple and complex versions of the course differed, it was 

necessary for the raters to know which complexity condition the creator of each PowerPoint course was in. 
However, raters were blind as to whether the creator participated in the LC or PC condition. Moreover, the 
study purpose and hypotheses were not shared with raters until after they completed their ratings.  
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skills”) because participants signed up for the study without prior knowledge of the 

nature of the experiment or the training course. Thus, these items were not relevant in the 

current study. Not surprisingly, these two items also had very low item-total correlations 

and the internal consistency of the scale improved considerably when these items were 

removed. Ultimately, motivation to learn was measured via a six item scale. Each item 

was measured on a five point Likert scale ranging from Strongly Disagree to Strongly 

Agree. An example item includes “I am motivated to learn the skills emphasized in the 

training program”. The six item measure showed very good internal consistency (α = 

.85).  

Trainee satisfaction. Although trainee satisfaction is not a key outcome of interest 

in this study, trainee satisfaction (or affective reactions) is a very commonly measured 

outcome variable in practice and research. The design of this study allows for the 

exploration of several, potentially interesting findings related to trainee satisfaction. For 

example, Brown (2005) and Orvis et al. (2009) have recently argued that the relation 

between trainee satisfaction and learning outcomes is (and should be) stronger in learner-

controlled training than in program-controlled training environments. They argue further 

that past research finding weak relationships between trainee satisfaction and learning 

have been primarily based on studies utilizing training courses that would be considered 

program-controlled. Because the design of this study allows for the exploration of this 

resurging issue in the e-learning literature, trainee satisfaction was measured using 

Brown’s (2005) measures of enjoyment and relevance. Brown’s (2005) research suggests 

that although these components of trainee reactions are related through an overall 

satisfaction construct, they should be considered distinct. Each measure consists of two 
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items and participants responded to each item on a five point Likert scale ranging from 

Strongly Disagree to Strongly Agree. Example items include “I enjoyed the training 

course” and “the training course was relevant to my education” (for enjoyment and 

relevance respectively). The measure of enjoyment showed excellent internal consistency 

(α = .90), while the relevance measure’s internal consistency was only moderate at .65. 

Procedure 

 Upon signing up for the study, participants were randomly assigned to one of four 

conditions; LC-complex, PC-complex, LC-simple and PC-simple. Unlike many e-

learning studies, trainees completed the course in computer labs alongside other trainees. 

Between 4 and 20 students participated during a single study session. While many e-

learning courses allow trainees to control the time and location of their training (e.g., 

Karim & Behrend, 2012; Sitzmann et al., 2009), the focus of this study is learners’ 

control over dimensions of learner control that are internal (i.e., instructional control) (v. 

external, e.g., location of training, time of day) to the training course that are likely to 

affect trainees’ exposure to the training material. Before entering the study session, each 

participant was emailed a document that included instructions, a pre-training survey, the 

embedded training course corresponding to the condition he/she was assigned to, a post-

course examination and instructions on completing the skill-based procedural knowledge 

activity. As part of the pre-training survey, participants first reported demographic 

information, including their highest composite ACT or SAT (verbal + quantitative) score.  

Participants then completed the PowerPoint familiarity, LGO and motivation to learn 

measures. Trainees then completed the embedded training course accompanying the 

condition to which they were assigned. The training courses in the two learner control 
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conditions were identical in the visual content presented. In total, the training course 

included three separate modules covering various operations in PowerPoint. Each 

training module was accompanied by a practice session which provided trainees with an 

opportunity to practice the skills that were taught in the preceding module.  

 Trainees in the LC conditions were instructed to allocate their time as they saw 

fit, complete the training course at their own pace, and skip or speed through any training 

material that they do not feel is necessary for them to cover (See Appendix H for a 

screenshot from the training course). Trainees in the PC condition were required to 

follow along with the instructions and pre-determined time frames embedded within the 

training course (See Appendix I for a screenshot from the training course). The degree of 

learner control was applied to the practice sessions as well as the training modules. In 

other words, trainees in the LC conditions were given full control over the amount of 

time they spent practicing the skills, whether they practiced the skills at all, etc. Trainees 

in the PC conditions were instructed to practice all skills in the allotted time (no more, no 

less). Thus, trainees in the PC condition spent approximately the same amount of time on 

each training module and the entire training course as a whole. The predetermined time 

frames used in the program-controlled condition were based on those used in Granger 

and Levine’s (2009) study. Specifically, the predetermined pacing for the PC-complex 

condition is as follows: 6 minutes for module 1, 6 minutes for practice session 1, 9 

minutes for module 2, 5 minutes for practice session 2, 7 minutes for module 3 and 5 

minutes for practice session 3. The total time predetermined for the PC-complex 

condition was 38 minutes. The predetermined pacing for the PC-simple condition is as 

follows: 4 minutes for module 1, 4 minutes for practice 1, 7 minutes for module 2, 5 
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minutes for practice session 2, 8 minutes for module 3 and 4 minutes for practice session 

3. The total time predetermined for the PC-easy condition was 32 minutes. Although the 

total time spent by trainees in the PC condition was predetermined, it was not recorded 

for trainees in the LC condition. Thus, time-on-task was not fully controlled for due to its 

minimal influence on learning in recent studies (e.g., Granger & Levine, 2009).  

 The simple and complex conditions differed in the amount of advanced 

PowerPoint operations covered in the training course. Trainees in the simple condition 

were required to learn only basic PowerPoint operations such as creating and saving a 

slideshow, entering text and text boxes, manipulating slide themes and display options, 

etc (See Appendix J for a screenshot from the simple condition). The complex condition 

covered these same operations in relatively less time (in the PC condition) and required 

trainees to learn more advanced operations such as applying SmartArt graphics, utilizing 

the Master Slide function, etc (See Appendix K for a screenshot from the complex 

condition). The LC and PC versions of complex course presented identical information 

visually to the learner. This was also the case for the LC and PC versions of the simple 

training course.  

Throughout the training course, a research assistant was available to aid all 

participants with technical problems or questions. Immediately following their 

completion of the training course, participants completed the perceived content 

complexity, perceived learner control and satisfaction measures. Participants then 

completed the cognitive load and metacognitive activities measures. Finally, participants 

completed the twenty item post-course examination and the skill-based procedural 
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knowledge activity. Participants then emailed their completed documents and skill-based 

procedural knowledge activity to the researcher. 
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Results 
 

Means, standard deviations and correlations among the focal variables are 

presented in Table 1. The descriptive statistics reported in Table 1 suggest that across the 

experimental conditions, trainees tended to score high on the post-course declarative (M 

= .88, SD = .14) and procedural knowledge examinations (M = .85, SD = .16). These 

findings suggest that the post-course exam was relatively easy for the average trainee. It 

should be noted, however, that when learning is operationalized as the total percentage of 

items correctly endorsed on the post-course examination, without regard to which 

complexity condition participants were in, participants in the complex condition (M = 

.84, SD = .12) scored several percentage points higher, on average, than participants in 

the simple condition (M = .78, SD = .12). This, of course, was expected since trainees in 

the complex condition were trained on all of the operations covered in the post-course 

examination while trainees in the simple condition were not.  
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Although PowerPoint familiarity was expected to relate positively with learning 

outcomes, the results suggest that self-reported familiarity with PowerPoint was not 

significantly correlated with performance on the post-course learning measures8. 

Specifically, PowerPoint familiarity was unrelated to declarative knowledge, r = -.03, n.s. 

(rc = -.05), procedural knowledge, r = .04, n.s. (rc = .06), overall cognitive learning, r = 

.01, n.s. (rc = .02), and skill-based procedural knowledge, r = .00, n.s. Thus, the bivariate 

relationships among PowerPoint familiarity and the learning outcomes indicate that it 

would not be useful as a covariate in the primary analyses. These results are very similar 

to those reported by Granger and Levine (2009) and are consistent with research 

suggesting that trainees are not always accurate assessors of their own knowledge (e.g., 

Bjork, 1994; Koriat & Bjork, 2005). In general, this finding has interesting implications 

for granting high levels of control to trainees based on the assumption that trainees know 

what they are already know and/or what they need to know. These implications will be 

discussed further in the Discussion.  

As expected, cognitive ability was positively and significantly related to the 

learning outcomes. For instance, cognitive ability was significantly correlated with 

declarative knowledge, r = .29, p < .0001 (rc = .48), procedural knowledge, r = .20, p < 

.001 (rc = .29), overall cognitive learning, r = .28, p < .0001 (rc = .36), and marginally 

significantly correlated with skill-based procedural knowledge, r = .14, p = .06. 

Interestingly, cognitive ability tended to have negative, albeit relatively weak 

relationships with the motivational variables and affective outcomes measured. 

                                                 
8 Because of the low reliability estimates observed for the declarative and procedural knowledge 

measures, corrected correlations with these variables are also presented throughout the Results section. In 
each case, I used Spearman’s correction-for-attenuation formula to correct for attenuation in both variables, 
unless reliability information was not available for the predictor (e.g., cognitive ability).  
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Specifically, cognitive ability was significantly and negatively related to LGO, r = -.12, p 

< .05, motivation to learn, r = -.16, p < .001, metacognitive strategies, r = -.14, p < .05, 

enjoyment, r = -.14, p < .05, and relevance, r = -.13, p < .05. Although cognitive ability 

was measured in order to control for its effects on the learning outcomes, the correlation 

between cognitive ability and the independent variables was explored as well as the 

interactions among cognitive ability and the independent variables for predicting learning 

outcomes, to provide a tests of the appropriateness of treating cognitive ability as a 

covariate. The latter of these addresses a critical assumption of ANCOVA: the 

homogeneity of regression slopes (Glass, Peckham, & Sanders, 1972). Results indicated 

that for all learning outcomes, cognitive ability had a significant interaction with at least 

one of the independent variables. This suggests that the slopes when regressing the 

learning outcomes onto cognitive ability for the four groups are not parallel (Glass, et al., 

1972)9. Thus, I did not treat cognitive ability as a covariate in the subsequent analyses.  

As expected, the motivational individual differences measured in this study were 

moderately to strongly correlated with each other. For example, LGO was positively 

related to motivation to learn, r = .81, p < .0001, and metacognitive activity, r = .35, p < 

.0001. These motivational individual differences were also quite strongly related to 

satisfaction, suggesting that trainees higher in LGO and motivation to learn enjoyed the 

training course and found the material to be more relevant than trainees lower in LGO 

and motivation to learn. Similarly, there were moderately strong, positive relationships 

between metacognitive activity and satisfaction, suggesting that trainees who engaged in 

                                                 
9 This essentially means that the adjustments made to the groups being compared when controlling 

for the effects of cognitive ability would not be uniform.  
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more metacognitive activities enjoyed training more and found the content to be more 

relevant than trainees who engaged in fewer metacognitive activities.  

 Cognitive load also had the expected relationships with other variables in the 

study. For example, cognitive load was strongly related to the content complexity 

condition, rpb = .43, p < .0001, with which trainees were assigned as well as perceptions 

of content complexity, r = .70, p < .0001. Cognitive load was also positively and 

significantly related to the learner control condition, rpb = .23, p < .001 with which 

trainees were assigned and perceptions of learner control, r = .17, p < .01. Finally, 

cognitive load was negatively correlated with declarative knowledge, r = -.16, p < .01 (rc 

= -.29), procedural knowledge, r = -.18, p < .01 (rc = -.29), overall cognitive learning, r = 

-.20, p < .01 (rc = -.28), and skill-based procedural knowledge, r = -.21, p < .01 

suggesting that, on average, trainees who perceived more cognitive load due to the 

training course acquired less declarative and procedural knowledge than trainees who 

experienced less cognitive load. Additionally, as would be expected by CLT, trainees 

reporting more familiarity with PowerPoint perceived less cognitive load, r = -.21, p < 

.001. 

Yet another finding worth noting is the positive relationship between learner 

control and metacognitive activity. Both objective learner control, rpb = .21, p <.001 and 

perceptions of learner control, r = .23, p < .001 were positively and significantly related 

to metacognitive activity. This finding suggests that while program-controlled 

environments may inhibit a learner’s ability to engage in metacognitive or self-regulatory 

activity due to the constraints of the training environment, learner-controlled 

environments may be more conducive, as they offer trainees the freedom to engage in 
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these types of activities. Nevertheless, the bivariate correlations suggest that objective 

learner control and perceptions of learner control were negatively related to the cognitive 

learning outcomes.  

 Additionally, several other important results are shown in Table 1, including the 

non-significant relations between trainee satisfaction and learning outcomes. While it has 

been recently argued that trainee satisfaction is an important predictor of learning in 

learner-controlled, computer-based training (Orvis, et. al., 2009), these results suggest 

that neither enjoyment nor relevance were correlated with the learning outcomes. For 

instance, the relationships between enjoyment and declarative knowledge, r = -.03, n.s. 

(rc = -.05), procedural knowledge, r = -.01, n.s. (rc = -.02), overall cognitive learning, r = 

-.03, n.s. (rc = -.05), and skill-based procedural knowledge, r = .001, n.s. were small in 

magnitude and non-significant. Likewise, the relevance was not significantly related to 

declarative knowledge, r = -.05, n.s. (rc = -.10), procedural knowledge, r = -.08, n.s. (rc = 

-.14), overall cognitive learning, r = -.08, n.s. (rc = -.13), or skill-based procedural 

knowledge, r = -.002, n.s. Interestingly, however, enjoyment was positively related to the 

complexity condition, rpb = .21, p < .01 and the learner control condition, rpb = .21, p < 

.01, suggesting that trainees in the complex and LC conditions enjoyed their training 

experience more than trainees in the simple and PC conditions respectively. Similarly, 

relevance was positively related to the complexity condition, rpb = .20, p < .01 and the 

learner control condition, rpb = .20, p < .01 suggesting that trainees in the complex and 

LC conditions found the training course to be more relevant to their education than 

trainees in the simple and PC conditions respectively. These findings have interesting 
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implications for the use of post-training learner reactions for justifying the use of learner-

controlled e-learning. These implications will be addressed in the Discussion.    

Manipulation Checks 

 To test the effectiveness of the learner control manipulation, an independent 

samples t-test was conducted, comparing the LC and PC conditions on the participants’ 

perceptions of learner control.  Consistent with the results of the pilot, the results suggest 

that the learner control manipulation was indeed effective, t(295) = -32.43, p < .0001, 

such that trainees in the LC condition (M = 4.70, SD = .43) perceived significantly more 

control over their learning than trainees in the PC condition (M = 1.72, SD = .43). I also 

ran an independent samples t-test to compare the LC and PC conditions on the cognitive 

load experienced by trainees. As expected, trainees in the LC condition (M = 1.55, SD = 

.75) reported experiencing significantly more detrimental cognitive load than trainees in 

the PC condition (M = 1.25, SD = .52), t(295) = -4.02, p < .001. An independent samples 

t-test was also conducted to test the effectiveness of the complexity manipulation, 

comparing the complex and simple conditions on the participants’ perceptions of the 

complexity of the training content. Again, consistent with the results of the pilot, the 

results suggest that the complexity condition was effective, t(295) = -11.59, p < .0001, 

such that trainees in the complex condition (M = 1.88, SD = .69) perceived the training 

content to be significantly more complex than trainees in the simple condition (M = 1.16, 

SD = .31). Additionally, I ran an independent samples t-test to compare the complex and 

simple conditions on the cognitive load reported by trainees. As expected, trainees in the 

complex condition (M = 1.68, SD = .75) reported experiencing significantly more 
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detrimental cognitive load than trainees in the simple condition (M = 1.12, SD = .39), 

t(295) = -8.09, p < .0001. 

Although participants were randomly assigned to the four conditions, I tested 

whether there were systematic differences among the experimental groups on the 

demographic variables measured. ANOVAs were conducted to determine if there were 

any differences between the conditions on age, cognitive ability and PowerPoint 

familiarity. Chi-square tests were used to determine differences between the groups on 

gender and race/ ethnicity. Interestingly, there was a significant difference among the 

four conditions for age, F(3, 291) = 3.30, p  < .05.  Post hoc analyses10 were conducted, 

indicating that the average age of participants in PC-simple (M = 19.76, SD = 1.64) 

condition was significantly lower than that of the LC-simple condition (M = 21.54, SD = 

4.33). Although the post hoc analyses suggest that there was no significant differences, 

the average age of participants in the PC-simple condition was also lower than that of the 

LC-complex (M = 21.42, SD = 3.76) and PC-complex (M = 20.77, SD = 4.65) conditions. 

Thus, I considered treating age as a covariate in the subsequent analyses. However, age 

was significantly correlated with the learner control condition, rbp = .16, p < .01 and thus 

was not included as a covariate due to its significant relationship with an independent 

variable. There were no significant differences across the conditions on self-reported 

familiarity with PowerPoint F(3, 293) = 1.81, n.s. or cognitive ability F(3, 276) = .91, n.s. 

A marginally significant difference was found for race/ ethnicity, χ2 (12, N = 297) 

= 19.91, p = .07.  A comparison of the racial breakdown of the conditions revealed that 

the PC-complex condition had a disproportionate number of Asian/ Pacific Islander 

                                                 
10 To control for the family-wise type I error rate, a Bonferroni adjustment was applied to all post 

hoc analyses 
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participants compared to the other conditions. In addition, the PC-simple condition had 

fewer Black/ African American participants than the other three conditions. ANOVAs 

were run for each of the learning outcomes to determine if there were any significant 

racial/ ethnic differences on the DVs. No significant differences among the group were 

observed for declarative knowledge, F(4, 292) = .74, n.s., procedural knowledge, F(4, 

292) = 1.02, n.s., or skill-based procedural knowledge, F(4, 191) = .27, n.s. Also, there 

were no significant differences across the conditions regarding the proportion of males 

and females, χ2 (3, N = 297) = 4.33, n.s.  

Finally, of the 297 participants, only 196 participants submitted a completed 

exercise for the skill-based procedural knowledge measure. Several ANOVAs were 

conducted to compare participants who completed and failed to complete the skill-based 

procedural knowledge measures on the demographic variables as well as motivational, 

satisfaction and other learning measures. No significant or notable differences were found 

between these groups on any of the relevant variables. Thus, it was determined that there 

were no systematic differences between trainees who completed the skill-based 

procedural knowledge exercise and those who chose not to. 

Hypothesis Tests 

As discussed above, cognitive ability, PowerPoint familiarity, participant age and 

race/ ethnicity were considered as potential covariates but cognitive ability interacted 

significantly with the independent variables and the remaining variables were unrelated 

to learning. Thus, no covariates were used in the subsequent analyses. In addition to the 

hypotheses regarding (a) declarative, (b) procedural, and (c) skill-based procedural 

knowledge, each hypothesis was tested for overall cognitive learning. To test hypothesis 

60 
 



 
 

1, that training content complexity moderates the relationship between the degree of 

learner control and (a) declarative knowledge, (b) procedural knowledge, and (c) skill-

based procedural knowledge, factorial ANOVAs were conducted for each of the learning 

outcomes. As shown in Table 2, a significant main effect was observed for learner control 

such that those in the PC condition (M = .89, SD = .13) outperformed learners in the LC 

condition (M = .86, SD = .15) on the declarative knowledge measure. Moderation of this 

main effect by complexity was also found, F(1, 293) = 3.71, p = .05,  = .012 and as 

illustrated in Figure 2, the interaction between learner control and training content 

complexity for predicting declarative knowledge acquisition was in the expected 

direction.  

Sum of Square df Mean Square F p
Intercept 227.37 1 227.37 11838.57 .00** .976
Learner Control .10 1 .10 5.15 .02* .017
Complexity .01 1 .01 .64 .43 .002
Learner Control*Complexity .07 1 .07 3.71 .05+ .012
Error 5.63 293 .02
Total 233.42 297
 +p < .10     * p < .05     ** p < .01

Table 2. ANOVA Results for Declarative Knolwedge
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Figure 2. Interaction between Learner Control and Training Content Complexity for 
Predicting Declarative Knowledge 

 

Similarly, as shown in Table 3, there were significant main effects for both 

learner control and complexity, and consistent with hypothesis 1(b) there was a 

significant interaction between learner control and training content complexity for 

predicting procedural knowledge acquisition, F(1, 293) = 12.80, p < .0001,  = .042. As 

illustrated in Figure 3, the interaction was in the expected direction. The main effects 

revealed again that those in the PC condition (M = .88, SD = .16) outperformed learners 

in the LC condition (M = .83, SD = .16) and those in the Simple condition (M = .89, SD = 

.16) outperformed learners in the Complex condition (M = .82, SD = .15) on the 

procedural knowledge measure. Interestingly, according to the effect size estimates, the 

interaction between learner control and training content complexity appears to account 

for more variance in procedural knowledge than for declarative knowledge.  
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Sum of Square df Mean Square F p
Intercept 216.52 1 216.52 9357.50 .00** .970
Learner Control .15 1 .15 6.30 .01* .021
Complexity .38 1 .38 16.20 .00** .052
Learner Control*Complexity .30 1 .30 12.80 .00** .042
Error 6.78 293 .02
Total 224.37 297

Table 3. ANOVA Results for Procedural Knowledge

* p < .05     ** p < .01  

 

70%

80%

90%

100%

Simple Complex

Pr
oc

ed
ru

al
 P

er
ce

nt
ag

e

Program Control

Learner Control

 
 
Figure 3. Interaction between Learner Control and Training Content Complexity for 
Predicting Procedural Knowledge 

 

As shown in Table 4, support was not found for hypothesis 1(c) such that there 

was a non-significant interaction between learner control and content complexity F(1, 

192) = 1.39, n.s. for predicting skill-based procedural knowledge. Mean differences 

amongst the conditions on skill-based procedural knowledge are shown in Figure 4. The 

significant main effect for complexity revealed that those in the Simple condition (M = 

11.08, SD = 1.60) received higher ratings on the skill-based procedural knowledge 

exercise than learners in the Complex condition (M = 8.79, SD = 2.41).  
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Sum of Square df Mean Square F p
Intercept 19189.41 1 19189.41 4428.98 .00** .958
Learner Control .06 1 .06 .01 .91 .000
Complexity 257.02 1 257.02 59.32 .00** .236
Learner Control*Complexity 6.01 1 6.01 1.39 .24 .007
Error 831.88 192 4.33
Total 20077.00 196

Table 4. ANOVA Results for Skill-based Procedural Knowledge

** p < .01  
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Figure 4. Interaction between Learner Control and Training Content Complexity for 
Predicting Skill-based Procedural Knowledge 
 

As mentioned above, the interaction between learner control and content 

complexity for predicting overall cognitive learning was also tested to offer additional 

insight into this relationship. As shown in Table 5, a significant main effect was observed 

for learner control such that those in the PC condition (M = .88, SD = .13) outperformed 

learners in the LC condition (M = .85, SD = .13) on the overall cognitive learning 

measure. A significant main effect was also observed for complexity such that those in 

the Simple condition (M = .89, SD = .14) scored a higher percentage on the post-course 
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exam on average than those in the Complex condition (M = .84, SD = .12). Most 

importantly, a significant interaction between learner control and complexity also 

observed, F(1, 293) = 10.80, p < .001,  = .036, and as illustrated in Figure 5, the 

interaction was in the expected direction. Conditional means and standard deviations for 

all learning outcomes are included in Table 6. Overall, the results largely support 

hypothesis 1, with only the results for skill-based procedural knowledge not attaining 

significance. 

Sum of Square df Mean Square F p
Intercept 222.01 1 222.01 14248.20 .00** .980
Learner Control .12 1 .12 7.57 .01* .025
Complexity .13 1 .13 8.53 .00** .028
Learner Control*Complexity .17 1 .17 10.80 .00** .036
Error 4.57 293 .02
Total 227.24 297

Table 5. ANOVA Results for Overall Cognitive Learning

* p < .05     ** p < .01  
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Figure 5. Interaction between Learner Control and Training Content Complexity for 
Predicting Overall Cognitive Learning 
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Table 6. Conditional Means and SDs on the Learning Outcomes

Mean SD Mean SD Mean SD Mean SD
Declarative Knolwedge .88 .16 .88 .15 .84 .14 .90 .11
Procedural Knolwedge .90 .14 .88 .19 .76 .15 .87 .13
Overall Cognitive Learning .89 .13 .88 .15 .80 .12 .89 .10
Skill-based Procedural Knolwedge 11.28 1.58 10.89 1.60 8.63 2.04 8.95 2.72

questions answered correctly

Variable

Note: Values for Declarative Knowledge, Procedural Knowledge and Overall Cognitive Learning represent percentages of relevant 

Complex ConditionSimple Condition
LC-Complex PC-ComplexLC-Simple PC-Simple

 

Because hypothesis 1(c) was not supported I proceeded to test hypothesis 2 for 

declarative knowledge, procedural knowledge and overall cognitive learning only. To test 

hypothesis 2, that the moderated relationship between training content complexity and (a) 

declarative, (b) procedural knowledge and overall cognitive learning is differentially 

mediated by cognitive load, I utilized a procedure developed by Preacher, Rucker, and 

Hays (2007). Preacher et al. (2007) developed an SPSS macro that allows for testing 

indirect conditional relationships (or moderated mediation). As was done for hypotheses 

1, separate tests were conducted for each of the learning outcomes. Cognitive load was 

mean centered prior to the analyses. As shown in Table 7, although the mediating effect 

of cognitive load for predicting declarative knowledge acquisition was marginally 

significant for the complex condition, the interaction between content complexity and 

cognitive load was not statistically significant. This means that the conditional indirect 

effects should not be interpreted. Thus, hypothesis 2(a) was not supported.  
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Table 7. Conditional Indirect Effects for Declarative Knolwedge
B SE t p

-.03 .02 -1.63 .10
-.01 .03 -.35 .73
.00 .02 .02 .98
-.03 .03 -.82 .41

        Cognitive load and Complexity

Level of moderator Boot indirect effect Boot SE LL 95% CI UL 95% CI Boot z Boot p

Simple -.004 .01 -.01 .01 -.41 .68
Complex -.012 .01 -.02 -.01 -1.84 .07+

Note: N = 279. LL - Lower Limit; UL = Upper Limit; CI = Confidence Interval. Unstandardized regression coefficients
are reported. Bootstrap sample = 5000
 +p  < .10  

Declarative Knolwedge regressed on the cross product of 

Variable
Declarative Knolwedge regressed on Learner Control
Declarative Knowledge regressed on Cognitive Load
Declarative Knowledge regressed on Complexity

Conditional indirect effects of cognitive load at levels of moderator

 

As shown in Table 8, a significant interaction between content complexity and 

cognitive load was observed (β = -.08, t = -2.23, p < .05). Moreover, the mediating effect 

of cognitive load for predicting procedural knowledge acquisition was marginally 

significant for both the simple and complex conditions. Despite the marginally significant 

indirect effects, according to Preacher et al.’s (2007) recommendations, the indirect 

effects can be interpreted because the confidence intervals for the indirect effect at both 

levels of the moderator do not include zero. Interestingly, the mediating effect of 

cognitive load was in the opposite direction for the complexity conditions. This suggests 

that the increased cognitive load induced by the complex condition led to decreased 

procedural learning for trainees in the complex condition as expected, while the cognitive 

load induced in the simple conditions appears to have had a positive impact on procedural 

learning.  
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Table 8: Conditional Indirect Effects for Procedural Knolwedge
B SE t p

-.04 .02 -2.21 .03*
.05 .03 1.49 .14
-.08 .02 -3.66 .00**
-.08 .04 -2.23 .03*

        Cognitive load and Complexity

Level of moderator Boot indirect effect Boot SE LL 95% CI UL 95% CI Boot z Boot p

Simple .02 .01 .01 .03 1.72 .09+

Complex -.01 .01 -.02 -.004 -1.66 .09+

Note: N = 279. LL - Lower Limit; UL = Upper Limit; CI = Confidence Interval. Unstandardized regression coefficients
are reported. Bootstrap sample = 5000
 +p  < .10     * p  < .05     ** p  < .01

Variable
Procedural Knolwedge regressed on Learner Control
Procedural Knowledge regressed on Cognitive Load
Procedural Knowledge regressed on Complexity
Procedural Knolwedge regressed on the cross product of 

Conditional indirect effects of cognitive load at levels of moderator

 

As a final test of hypothesis 2, I applied the same analytical approach, treating 

overall cognitive learning as the outcome variable. As shown in Table 9, a significant 

interaction between content complexity and cognitive load was observed (β = - .06, t = -

1.99, p < .05). Moreover, the mediating effect of cognitive load for predicting overall 

cognitive learning was significant for the complex condition only. Similar to the results 

for procedural knowledge, the mediating effect of cognitive load suggests that the 

increased cognitive load induced by the complex condition led to impaired cognitive 

learning. Overall, some support was found for hypothesis 2, specifically for procedural 

knowledge and overall cognitive learning. 

Table 9: Conditional Indirect Effects for Overall Cognitive Learning
B SE t p

-.04 .02 -2.23 .03*
.02 .03 .81 .42
-.04 .02 -2.29 .02*
-.06 .03 -1.99 .04*

        Cognitive load and Complexity

Level of moderator Boot indirect effect Boot SE LL 95% CIUL 95% CI Boot z Boot p

Simple .01 .01 .00 .02 1.01 .31
Complex -.01 .01 -.02 -.01 -1.98 .04*

Note: N = 279. LL - Lower Limit; UL = Upper Limit; CI = Confidence Interval. Unstandardized regression coefficients
are reported. Bootstrap sample = 5000
* p  < .05

Variable
Cognitive Learning regressed on Learner Control
Cognitive Learning regressed on Cognitive Load
Cognitive Learning regressed on Complexity
Cognitive Learning regressed on the cross product of 

Conditional indirect effects of cognitive load at levels of moderator
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Finally, although hypothesis 1(c) was not supported, a large main effect for the 

complexity condition was observed, such that learners in the Simple condition 

significantly outperformed those in the Complex condition on the skill-based procedural 

knowledge exercise. Thus, I tested whether cognitive load mediates the relationship 

between content complexity and skill-based procedural knowledge. To test this, I utilized 

the steps outlined by Preacher and Hays (2004) for testing simple mediation models. As 

shown in Table 10, cognitive load did not mediate the relationship between training 

content complexity and skill-based procedural knowledge. The most likely explanation 

for this main effect is that because the Simple and Complex conditions differed 

substantially in the PowerPoint operations covered, raters of the skill-based procedural 

knowledge exercises considered participants’ use of different operations when rating their 

exercises.  

Table 10. Simple Mediation for Skill-based Procedural Knolwedge as Dependent Variable 
B SE t p

.47 .09 5.12 .00**
-.16 .23 -.70 .48

-2.29 .30 -7.67 .00**

Value LL 95% CI UL 95% CI z p

Sobel -.08 -.19 .03 -.70 .49
M LL 95% CI UL 95% CI

Effect -.08 -.21 .05
Note: N = 297. LL - Lower Limit; UL = Upper Limit; CI = Confidence Interval. Unstandardized regression coefficients
are reported. Bootstrap sample = 5000
** p  < .01

.11
SE

Bootstrap results for indirect effect
.13

Variable
Cognitive Load regressed on Complexity (a path)
Skill-based Procedural regressed on Cognitive Load (b path)
Skill-based Procedural regressed on Complexity (c path)

SE
Indirect effect and significance test

 

To test hypothesis 3, that there is a three-way interaction between learner control, 

content complexity and LGO, such that learners high in LGO will outperform learners 

low in LGO in the LC-complex condition, but less so in the PC conditions, I utilized the 

PROC GLM Univariate procedure in SPSS. The two manipulated variables, learner 
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control and content complexity, were entered as fixed factors. LGO was mean centered 

prior to analysis and was entered as a covariate in the model. Main effect, two-way and 

three-way interaction terms among learner control, content complexity and LGO were 

also entered into the model. Separate analyses were run for (a) declarative, (b) procedural 

knowledge and overall cognitive learning. In support of hypothesis 3(a) and as shown in 

Table 11, there was a significant three-way interaction between learner control, content 

complexity and LGO for predicting declarative knowledge, F(1, 289) = 5.02, p < .05,  

= .017. Utilizing procedures outlined by Aiken and West (1991), the interaction between 

content complexity and LGO for each learner control condition was plotted to examine 

the nature of the three way interaction. As recommended by Cohen and Cohen (1983), 

values of LGO are plotted at +/-1 SDs from the mean. As illustrated in Figure 6, LGO 

appears to positively predict declarative knolwedge, but only for learners in the LC-

complex condition. The slopes for the remaining conditions appear to be flat to slightly 

negative. Additionally, I used procedures outlined by Preacher, Curran and Bauer (2006) 

to investigate the simple slopes for each group. Results of these simple slope analyses 

indicate that none of the slopes differed significantly from 0. Nevertheless, I considered 

the possibility that the regression slopes for the conditions differ significantly from one 

another. To test this, I used an application developed by Dawson and Richter (2006). 

Results of this analysis suggest that the regression slope for the LC-complex condition, 

when regressing declarative knowledge on LGO, was marginally significantly different 

from the slope for the LC-simple condition, t = 1.76, p = .08, but the regression slope for 

the LC-complex condition was not significantly different from the slopes of the PC 

conditions.  
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Sum of Squares df Mean Square F p
Intercept 218.12 1 218.12 11693.79 .00** .976
Learner Control .14 1 .14 7.74 .01* .026
Complexity .01 1 .01 .55 .46 .002
LGO .01 1 .01 .38 .54 .001
Learner Control*Complexity .06 1 .06 2.95 .08+ .010
Learner Control*LGO .05 1 .05 2.69 .10 .009
Complexity*LGO .08 1 .08 4.17 .04* .014
Learner Control*Complexity*LGO .09 1 .09 5.02 .03* .017
Error 5.39 289 .02
Total 233.42 297
 +p < .10     * p < .05     ** p < .01

Table 11. Three Way Interaction Results for Declarative Knowledge
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Figure 6. Interaction between Learner Control, Training Content Complexity and LGO 
for Predicting Declarative Knowledge 
 

Despite finding a significant three-way interaction for declarative knowledge, a 

non-significant three-way interaction was observed for procedural knowledge, F(1, 289) 

= 1.74, n.s. As shown in Table 12, the three-way interaction among learner control, 
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content complexity and LGO does not predict procedural knowledge above and beyond 

the main effects and two-way interactions.    

Sum of Squares df Mean Square F p
Intercept 207.79 1 207.79 8916.92 .00** .969
Learner Control .14 1 .14 5.98 .02* .020
Complexity .33 1 .33 14.20 .00** .047
LGO .00 1 .00 .10 .75 .000
Learner Control*Complexity .30 1 .30 12.83 .00** .043
Learner Control*LGO .00 1 .00 .07 .79 .000
Complexity*LGO .00 1 .00 .19 .67 .001
Learner Control*Complexity*LGO .04 1 .04 1.74 .19 .006
Error 6.74 289 .02
Total 224.37 297
* p  < .05     ** p  < .01

Table 12. Three Way Interaction Results for Procedural Knowledge

 

Similar to the results for declarative knowledge knowledge and as shown in Table 

13, there was a significant three-way interaction between learner control, content 

complexity and LGO for predicting overall cognitive learning, F(1, 289) = 4.28, p < .05, 

 = .015. Again, I utlized procedures outlines by Aiken and West (199) to plot the three 

way interaction. As illustrated in Figure 7, the pattern of results looks very similar to that 

of declarative knowledge. That is, LGO appears to positively predict cognitive learning, 

but only for learners in the LC-complex condition. Again, I used procedures outlined by 

Preacher et al., (2006) to investigate the simple slopes for each group. Results of these 

simple slope analyses indicate that none of the slopes differed significantly from 0. 

Additionally, the slope for the LC-complex condition did not differ signitncaly from the 

regression slope for any other condition. Thus, partial support was found for hypothesis 

3, and the interactions suggest that LGO may matter most by facilitating cognitive 

learning in complex, learner-controlled environments. 
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Sum of Square df Mean Square F p
Intercept 212.96 1 212.96 13746.26 .00** .979
Learner Control .14 1 .14 8.80 .00** .03
Complexity .12 1 .12 7.51 .01* .025
LGO .00 1 .00 .00 .96 .000
Learner Control*Complexity .16 1 .16 10.22 .00** .034
Learner Control*LGO .01 1 .01 .50 .48 .002
Complexity*LGO .01 1 .01 .59 .44 .002
Learner Control*Complexity*LGO .07 1 .07 4.28 .04* .015
Error 4.48 289 .02
Total 227.24 297
* p  < .05     ** p  < .01

Table 13. Three Way Interaction Results for Overall Cognitive Learning
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Figure 7. Interaction between Learner Control, Training Content Complexity and LGO 
for Predicting Overall Cognitive Learning 
 

Finally, because the importance of LGO for predicting learning in the complex, 

learner-controlled condition is of particular interest in this study, I explored the 

correlation between LGO and the learning outcomes when selecting only trainees in the 

LC-complex condition. Results revealed that LGO was positively and signficantly related 

73 
 



 
 

to declarative knowledge, r = .32, p < .01 (rc = .56) and overall cognitive learning, r = 

.23, p < .05 (rc = .31), but not significantly related to procedural knowledge, r = .06, n.s. 

(rc = .09), or skill-based procedural knowledge, r = .05, n.s.  

Because hypothesis 3(b) and 3(c) were not supported I proceeded to test 

hypothesis 4 only for declarative knowledge and overall cognitive learning. To test 

hypotheses 4(a), that metacognition mediates the relationship between LGO and 

declarative knowledge and overall cognitive learning such that high LGO learners engage 

in more metacognitive activity during training than low LGO learners, I used the steps 

outlined by Preacher and Hays (2004) who developed an SPSS macro designed to test 

simple mediation models. As shown in Tables 14 and 15, metacognitive activity did not 

mediate the relationship between LGO and either declarative knowledge or overall 

cognitive learning. While this finding is somewhat surprising given the extant research in 

support of this relationship, I considered the possibility that the PC condition repressed 

the expression of LGO and metacognition. Thus, I used the same simple mediation 

procedure for trainees in the LC condition only. However, the results suggest that even 

for trainees in the LC conditions, metacognitive activity did not mediate the relationship 

between LGO and declarative or cognitive learning. Overall, hypothesis 4 was not 

supported. 
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Table 14. Simple Mediation for Declarative Knolwedge as Dependent Variable 
B SE t p

.42 .07 6.50 .00**
-.002 .01 -.17 .86
-.01 .01 -.63 .53

Value LL 95% CI UL 95% CI z p

Sobel -.001 -.005 .003 -.17 .86

M LL 95% CI UL 95% CI

Effect -.001 -.004 .003
Note: N = 297. LL - Lower Limit; UL = Upper Limit; CI = Confidence Interval. Unstandardized regression coefficients are reported.
Bootstrap sample = 5000
** p  < .01

.004

Metacognitive Activity regressed on LGO (a path)
Declarative Knowledge regressed on Metacognitive Activity (b path)
Declarative Knowledge regressed on LGO (c path)

Variable

Bootstrap results for indirect effect

Indirect effect and significance test
SE

SE

.004

 

 

Table 15. Simple Mediation for Overall Cognitive Learning as Dependent Variable 
B SE t p

.42 .07 6.50 .00**
-.004 .01 -.43 .69
-.004 .01 -.45 .65

Value LL 95% CI UL 95% CI z p

Sobel -.002 -.006 .002 -.43 .67

M LL 95% CI UL 95% CI

Effect -.002 -.006 .002
Note: N = 297. LL - Lower Limit; UL = Upper Limit; CI = Confidence Interval. Unstandardized regression coefficients are reported.
Bootstrap sample = 5000
** p  < .01

.004

SE
Bootstrap results for indirect effect

.004

Variable
Metacognitive Activity regressed on LGO (a path)
Cognitive Learning regressed on Metacognitive Activity (b path)
Cognitive Learning regressed on LGO (c path)

SE
Indirect effect and significance test

 

 

Additional Analyses 

 In addition to testing the formal hypotheses presented in this paper, there were 

several opportunities to explore important research questions that are resurging in the e-

learning and learner control literatures. For instance, recent work by Brown (2005) and 

Karin Orvis and her colleagues (e.g., Fisher, et al, 2010; Orvis, et al., 2009) suggests that 

trainee satisfaction should be more strongly (and positively) related to learning in learner-

controlled environments (v. program-controlled environments). However, the results of 

this study suggest that trainee satisfaction (both enjoyment and relevance) is not 
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necessarily positively related to learning. Across the conditions, enjoyment showed non-

significant relationships with declarative, r = -.03, n.s. (rc = -.03) and procedural 

knowledge gain, r = -.01, n.s. (rc = -.02) as well as skill-based procedural knowledge (r = 

.00, n.s.). Likewise, relevance showed non-significant relationships with declarative, r = -

.05, n.s. (rc = -.10) and procedural knowledge gain, r = -.08, n.s. (rc = -.14) and skill-

based procedural knowledge (r = .00, n.s.). More interestingly, the interaction between 

learner control and the satisfaction components was explored. To directly test Brown 

(2005) and Orvis et al.’s (2009) prediction that trainee satisfaction is more strongly 

related to learning in learner-controlled environments (v. program-controlled 

environments), I conducted multiple regression analyses for all learning outcomes. The 

interactions between enjoyment and learner control and relevance and learner control 

were explored separately for each DV. Continuous variables were mean-centered prior to 

analysis. Main effects for learner control and the satisfaction component and the 

interaction term between the variables were entered in the model. All interactions were 

plotted using the procedures outlined by Aiken and West (1991). For declarative 

knowledge there was a non-significant interaction between learner control and learner 

enjoyment for predicting declarative knowledge, F(1, 293) = 1.62, n.s. As would be 

predicted by Orvis and colleagues, the relationship between enjoyment and the learning 

outcomes should be more positive for the LC condition. As is shown in Figure 8, this was 

not the case.  
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Figure 8. Interaction between Learner Control and Enjoyment for Predicting Declarative 
Knowledge 
 

 Similarly, the interaction between learner control and relevance was explored. 

Results revealed a significant interaction between learner control and relevance for 

predicting declarative knowledge, F(1, 293) = 7.33, p < .01,  = .02. However, when the 

interaction was plotted (see Figure 9), the results run contrary to Brown (2005) and Orvis 

et al.’s (2009) prediction. That is, while there appears to be no meaningful relationship 

between perceptions of relevance and declarative knowledge in the PC condition, the 

relationship between relevance and declarative knowledge was actually negative in the 

LC condition.  
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Figure 9. Interaction between Learner Control and Relevance for Predicting Declarative 
Knowledge 

 

Similar to the results for declarative knowledge, while there was a significant 

interaction between learner control and enjoyment for predicting procedural knowledge, 

F(1, 293) = 4.97, p < .05,  = .02, the interaction was not in the predicted direction (see 

Figure 10). Brown (2005) and Orvis, et al.’s (2009) prediction that satisfaction is more 

positively and strongly related to learning outcomes was not supported. Likewise, a 

significant interaction between learner control and relevance was observed for predicting 

procedural knowledge was observed, F(1, 293) = 4.00, p < .05,  = .013, but the nature 

of the interaction suggests that perceptions of relevance are actually negatively related to 

procedural knowledge for trainees in the LC condition (see Figure 11). Non-significant 

interactions were observed between enjoyment and learner control, F(1, 192) = .14, n.s., 

and relevance and learner control, F(1, 192) = .42, n.s., for predicting skill-based 

procedural knolwedge. 
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Figure 10. Interaction between Learner Control and Enjoyment for Predicting Procedural 
Knowledge 
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Figure 11. Interaction between Learner Control and Relevance for Predicting Procedural 
Knowledge 
 

Additionally, I conducted simple comparisons of the LC and PC conditions on the 

affective, cognitive and behavioral outcomes. The results of independent samples t-tests, 
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comparing the LC and PC conditions on several outcome variables, suggests that overall, 

trainees in the LC condition enjoyed and found the content to be more relevant to their 

education than trainees in the PC condition (t(295) = -3.77, p < .0001. for enjoyment and 

t(295) = -3.47, p < .001 for relevance). Despite these more positive affective reactions to 

the LC condition, trainees in the PC condition actually showed better scores on the 

cognitive learning measures11. Specifically, and as shown above, trainees in the PC 

condition outperformed trainees in the LC condition on both the declarative, t(295) = 

2.26, p < .05, and procedural knowledge, t(295) = 2.35, p < .05, measures. However, 

there was a non-significant difference between trainees in the LC and PC conditions for 

skill-based procedural knowledge, t(194) = .01, n.s. Taken together, these results suggest 

that trainee satisfaction is not necessarily a reliable or positive predictor of learning, even 

in learner controlled training environments. 

 It has also been argued in the e-learning literature that learner control allows for 

(cognitively) active learning (Mayer, 2008) which is expected to be beneficial to learning. 

For example, trainees in learner-controlled training environments are free to learn at their 

own pace and engage in metacognitive activities that they may not have had the 

opportunity to engage in during program-controlled training due to the constraints of 

these environments. Simply stated, learner control opens the door for metacognition and 

self-regulation. To explore this research question, an independent samples t-test was 

conducted, comparing the learner control conditions on metacognitive activity. As 

expected, trainees in the LC condition reported engaging in more metacognitive activities 

                                                 
11 It should be noted that this main effect is largely driven by the interaction between learner 

control and training content complexity. In other words, the difference between trainees in the LC and PC 
conditions is due primarily to the fact that trainees in the LC-complex condition suffered the most in terms 
of the learning of the training material.  
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than trainees in the PC condition, t(295) = -3.60, p < .0001. Although the results of 

hypothesis 4 suggests that metacognitive activity did not mediate the relationship 

between LGO and learning outcomes, and the presumptive increased metacognitive 

activity did not mirror the amount of learning, where PC conditions were superior on 

declarative and procedural knowledge measures, the well established relationship 

between metacognitive activity leads to optimism about the role of metacognition/ self-

regulation in e-learning environments. The implications of these additional findings are 

discussed below. 
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Discussion 
 

This dissertation adds to the e-learning and learner control literatures in several 

important ways. First and foremost, this study builds on the seminal work of Granger and 

Levine (2009) by exploring the interactive relationship between learner control and 

training content complexity for predicting multiple cognitive and behavioral learning 

outcomes. Unlike Granger and Levine (2009), the manipulation of learner control did not 

confound learner control with the presence (absence) of an instructor, which is known to 

influence trainees’ affective reactions (Sitzmann, et al., 2008) and potentially other 

variables that may predict learning (e.g., self-regulatory activity, metacognition). Thus, 

this study provides a more robust test of the interaction between learner control and 

training content complexity in e-learning. This study also found that cognitive load 

mediates this complex relationship suggesting that complex, learner controlled 

environments are detrimental to cognitive learning, at least partially, because they place a 

high level of cognitive load onto trainees, which consumes important cognitive resources 

during training. Additionally, this study answers Granger and Levine’s (2010) call for 

research on individual differences that may help learners cope with the heavier cognitive 

demands that complex, learner-controlled training environments place on learners. 

Moreover, the mechanism through which these individual differences influence learning 

was explored (i.e., metacognitive activity). Finally, this dissertation addressed several 

resurging issues in the e-learning literature such as the relative importance of trainee 

satisfaction for predicting learning outcomes in learner- and program-controlled 
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environments (e.g., Orvis, et al., 2009) and the isolation of specific components of learner 

control (e.g., Karim & Behrend, 2012; Kraiger & Jerden, 2007).  

Summary of Findings 

As noted above, the first and arguably most important contribution of this study is 

the replication of Granger and Levine’s (2009) findings regarding training content 

complexity. To date, e-learning research has been heavily focused on design 

characteristics and individual differences that predict affective and cognitive outcomes. 

Much less attention has been paid to characteristics of the training content itself. The 

results of this dissertation are consistent with Granger and Levine’s conclusion that the 

complexity of the content being trained is an important intervening variable in the learner 

control-learning relationship. While there does not appear to be any meaningful 

difference, in terms of learning, between learner- and program-controlled e-learning for 

the training of relatively simple content, learners who are placed in complex learner-

controlled environments show poorer cognitive learning outcomes than learners in 

complex, program-controlled environments. This study, however, did not replicate this 

interaction for skill-based procedural knowledge. While the general pattern of group 

means for skill-based procedural knowledge is supportive of the hypotheses in this study, 

and consistent with the findings of Granger and Levine (2009), the group means did not 

differ significantly from one another. It is possible that the task required to assess skill-

based procedural knowledge was insufficiently sensitive to capture the differences among 

trainees. 

While Granger and Levine (2009) found limited support for time-on-task as a 

mediator, this study identified cognitive load as a potential mediator of the moderated 
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relationship between learner control and training content complexity for predicting 

procedural and overall cognitive learning. The results of this study suggest that complex, 

learner-controlled training environments require greater cognitive resources and 

introduce a greater level of intrinsic and extraneous cognitive load onto the average 

learner. This increased (detrimental) cognitive load consumes trainees’ valuable mental 

resources throughout training and thus leads to decreased cognitive learning outcomes in 

complex environments. Despite these unfavorable findings for complex, learner-

controlled training environments, the results also suggest that increased cognitive load 

actually aids in procedural learning in simple conditions. It is possible that trainees who 

perceived the simple course to be very easy became disengaged and/or skipped over 

training content that ultimately inhibited their learning. In addition, these findings suggest 

that instructional features designed to reduce the complexity of intrinsically complex 

content or (perhaps more realistically) reduce the extraneous cognitive load introduced to 

learners via complex, learner-controlled e-learning, may help ameliorate these issues 

(Krischner, 2002; Mayer, 2008).  

This study also investigated LGO as a potentially important individual difference 

variable that may help trainees overcome the high cognitive demands introduced by 

complex, learner-controlled environments. While the three way interaction between 

learner control, content complexity and LGO did not predict procedural learning above 

and beyond the main effects and two-way interactions, there was a significant three-way 

interaction for predicting declarative knowledge and overall cognitive learning. 

Specifically, the predicted means suggest that a high LGO facilitates cognitive learning in 

complex, learner-controlled environments relative to less demanding training 
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environments. Indeed, LGO was found to be a strong predictor of declarative learning for 

trainees in the LC-complex condition. This suggests that high LGO learners acquire more 

knowledge than low LGO learner in complex, learner-controlled environments.  

Finally, metacognitive activity was explored as a mediator to explain why high 

LGO learners are able to more effectively learn, especially in complex, learner-controlled 

environments. Despite research is support of this mediated relationship (Schmidt & Ford, 

2003), no evidence for this was found, even when the relationship was tested for only 

trainees in the LC-complex condition, where the constraints of the PC condition were not 

present and the expression of motivational individual differences is more likely. While 

high LGO learners acquired more declarative knowledge than low LGO learners in the 

complex, learner-controlled condition, self-reported metacognitive activity does not 

mediate this relationship. It has been surmised that self reports measures of metacognitive 

activity may not actually reflect the degree to which trainees use metacognitive strategies. 

While the measure used here showed very strong internal consistency, it may be overly 

presumptive to assume that undergraduates, especially those not trained, or primed to 

engage in one or more of these strategies, could recognize that they were doing so.  

Summary of Additional Findings 

This design of this study allowed for the exploration of a resurging issue in the 

training literature: the relative importance of trainee satisfaction for predicting cognitive 

and behavioral learning outcomes. Despite the large volume of research suggesting that 

trainee satisfaction (or at least enjoyment) and learning outcomes are weakly related 

(Alliger, et al., 1997; Colquitt et al., 2000; Sitzmann et al., 2008), Brown (2005) and 

Orvis et al. (2009) have recently argued that trainee satisfaction may play a more 
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important role for predicting learning when trainees are in learner-controlled v. program-

controlled environments. Although their reasoning suggests that trainee satisfaction leads 

learners to be more engaged in the learning process and thus is a stronger predictor in 

learner-controlled environments due to the greater discretion afforded to learners in these 

environments, the results of this study do not support these expectations. In fact, the 

results of this dissertation echo the findings of past research (e.g., Alliger, et al., 1997; 

Colquitt et al., 2000) that suggest that trainee affective reactions are not reliable (or 

necessarily positive) predictors of learning outcomes.  

Implications and Future Research 

 While learner control is often touted as a key advantage of e-learning (Kinzie & 

Sullivan, 1986) and often goes hand-in-hand with it (Granger & Levine, 2010), the results 

of this study clearly suggest that learner control can be divorced from e-learning and in 

complex training environments, doing so may actually be beneficial to learning. 

Adopting learner-controlled e-learning without consideration of the potential complexity 

of the content to trainees may lead to decreased learning and perhaps ultimately lower 

levels of transfer of training. On the other hand, when the content of training is relatively 

simple (e.g., annual refresher training on content that employees are very familiar with, 

training with few interconnected pieces of novel information), presenting training 

material via learner-controlled e-learning can be just as effective and perhaps more 

efficient than program-controlled e-learning.  

While this study focused on detrimental (intrinsic and extraneous) cognitive load, 

it has been argued in the CLT literature that germane cognitive load (or generative 

processing) actually leads to enhanced learning outcomes. This is quite similar to the 
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findings in some of the training literature in support of self-regulatory and self-evaluative 

prompting (Sitzmann et al., 2009; Sitzmann & Ely, 2010). When learners engage in these 

types of activities (e.g., goal setting, self-testing) they are contributing to their learning of 

the training material. Interestingly, although learner-controlled environments do appear to 

‘open the door’ to metacognitive activity, it is clear that not all trainees are willing/ able 

to engage in these deeper strategies (Brown, 2001) without prompting. As suggested by 

Granger and Levine (2010), research should explore self-regulatory prompting and other 

training design features/ techniques that may increase germane cognitive load as these 

interventions may help trainees in learner-controlled environments better handle the high 

degree of cognitive load induced. And while metacognitive activity was measured as an 

individual difference with a self-report scale in this study, there appear to be limitations 

to measuring it as such (Whitebread, et al., 2009). One important area of future research 

is to determine the relative effectiveness of self-regulatory prompting or other similar 

design features that are employed in relatively simple v. highly complex e-learning 

environments. Other interventions that work to reduce the intrinsic and extraneous 

cognitive load experienced by learners should also be explored in the research. In 

practice, for example, if the training content is expected to be novel to most trainees, 

providing trainees with preparatory materials (e.g., outlines, flow charts) may assist 

trainees in building mental models of the processes or operations during training. Another 

potential avenue to avoid negative learning outcomes in high learner control conditions 

might be to intersperse quizzes to test mastery of training segments, and require that 

trainees review tested material when they answer incorrectly. This could help trainees 
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avoid the error of assuming mastery when it has not been achieved (e.g., Bjork, 1994; 

Granger & Levine, 2010).  

From an individual difference perspective, the results of this study suggest that 

high LGO learners are able to acquire more declarative knowledge than low LGO 

learners in complex, learner-controlled e-learning. As discussed earlier in this paper, state 

LGO can be induced (Button et al., 1996; Locke & Latham, 2006) and positively 

influenced prior to and during training (Chiaburu et al., 2010; Heckhausen & Kuhl, 1985; 

Kozlowski & Bell, 2006). In an organizational training setting, trainers and instructional 

designers may include simple framing cues or instructions such as error encouragement 

and describing errors during training as learning opportunities (Bell & Kozlowski, 2008) 

and describing learners’ abilities as malleable as opposed to being fixed. Similarly, 

eliminating error avoidance instructions during training can help learners adopt a learning 

goal orientation. For example, the results of Keith and Frese’s (2008) meta-analysis on 

error management training (similar to error encouragement) led them to conclude that 

placing an emphasis on within-training performance (e.g., performance on practice 

exercises throughout training) is not necessarily beneficial. It is also likely that 

employees who work in organizations that foster a climate of learning in training 

environments will be more likely to adopt a learning goal orientation. These simple and 

time-efficient interventions can ultimately help buffer trainees to the high cognitive 

demands that are characteristic of complex, learner-controlled environments. More 

research on the effectiveness of such interventions in complex, learner-controlled 

environments is needed to confirm these propositions.  
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 Additionally, this study focused on the training of a software package. The 

ultimate objective of the PowerPoint training course was cognitive and behavioral 

learning and ultimately transfer or training. However, cognitive and behavioral learning 

is not always the ultimate objective of training programs. For example, there are 

numerous examples of training courses that are designed to train affective outcomes, such 

as self-efficacy, motivation, etc. (Kraiger, et al., 1993), as well as psychomotor skills. It is 

unclear whether the interaction between learner control and complexity holds when the 

key outcomes of training is affective or psychomotor in nature. Moreover, there is very 

little research on the differential effectiveness of learner- and program-controlled training 

for the training of affective and psychomotor learning outcomes. In the latter case 

providing a high degree of learner control may result in accidents and injuries. Additional 

research should investigate these differences for training programs that differ in their 

ultimate learning objectives.  

Beyond the primary hypotheses tested in this study, several additional findings 

have interesting implications for e-learning research and practice. For instance, the 

finding that trainees’ self-reported familiarity with PowerPoint was not related to learning 

may also speak to the findings that trainee self-assessments and judgments of knowledge 

are not always accurate (Koriat & Bjork, 2005), especially in web-based training 

environments (Sitzmann et al., 2010). Interestingly, while many self assessments of 

knowledge are very general (e.g., How much do you know about ___?), the PowerPoint 

familiarity measure that was used in this study asked participants to rate their familiarity 

with very specific operations in PowerPoint. It can be reasonably argued that a more 

precise measure, such as the one used in this study, would more accurately reflect what 
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the trainee actually knows about PowerPoint compared to a global measure. Nevertheless, 

the findings suggest that trainees’ self-reported familiarity with the content being trained 

is not necessarily a good indication of what they actually know about a topic.  

 It has been argued that one of the advantages of learner-controlled e-learning is 

that it places the learner in the driver’s seat of training (Kozlowski & Bell, 2006) and the 

learner is ultimately the best judge of what he/she knows and needs to know (Niemiec, 

Sikorski, & Walberg, 1996). Consistent with Granger and Levine’s (2010) argument, the 

results of this study suggest that while learner-controlled e-learning environments do 

indeed offer trainees more control, the assumption that learners are uniformly the best 

judges of their own learning needs is likely misguided and may lead to inferior cognitive 

learning outcomes. It is quite possible that trainees who scored very high on the 

PowerPoint familiarity measure and felt that they were already familiar with the 

operations in the course, sped through some of the training modules and practice sessions 

and/or engaged in more off-task attention and thus reduced their exposure to the training 

material. This is likely a common scenario in organizational training environments, 

where employees have some baseline knowledge but are given the freedom to skip or 

speed through content that they are already familiar with or ‘already know’. Moreover, 

these environments may increase the cognitive load placed on learners which further 

inhibits their ability to learn the material.  

 Additionally, it has been argued recently that trainee satisfaction is an important 

predictor of learning when trainees are in learner-controlled environments (Brown, 2005; 

Orvis et al., 2009). The results of this study do not support this position. Rather, the 

results suggest that while the average trainee may be more satisfied with learner-
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controlled training environments, their learning can suffer in these environments when 

the content of training is complex in nature. While affective reactions are some of the 

most commonly measured outcomes in organizational training environments, these 

results imply that justifying the use of learner-controlled e-learning based on positive 

trainee reactions to these environments is likely misguided, as learning and transfer may 

inadvertently suffer.  

A similar issue that deserves additional attention from researchers is the issue of 

whether trainee preferences for learner control are reliable predictors of important 

training outcomes (e.g., Kraiger & Jerden, 2007). For example, does the practice of 

tailoring the degree of learner control to each learner based on their preferences for 

control lead to improved affective and learning outcomes? As there is little research on 

how trainees’ preferences for learner control relate to affective, cognitive and behavioral 

learning outcomes (see Fisher et al., 2010 for an exception), additional research is needed 

to explore how trainees’ conscious (or subconscious) preferences for learner control 

impact their learning when their preferences are matched with objective levels of learner 

control. Additionally, as suggested by Kraiger and Jerden’s (2007) model of learner 

control, individual factors such as cultural factors (e.g., power distance; uncertainty 

avoidance) may predict learner preferences for control as well as learning outcomes in 

these environments. Researchers should explore these issues as they may have important 

implications for the delivery of e-learning in multi-national organizations.  

Limitations 

There are several limitations of this study that should be addressed. First, it is 

possible that the use of a college student sample may reduce the generalizability of these 
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findings. Despite this possibility, it has been well argued (e.g., Greenberg, 1987) and 

empirically demonstrated (e.g., Locke, 1986) that student samples are not necessarily less 

representative than samples of working adults. In fact, recent meta-analytic work by 

Sitzmann and Ely (2011) suggests that the effects of self-regulatory processes (e.g., 

metacognition) in training do not differ substantially across employee and student 

populations. Perhaps a more important potential limitation is that college students 

completing a training course for extra credit may not be as motivated to learn as 

employees completing job-relevant or perhaps job-impacting (e.g., required certification 

course) training. Allaying this concern, trainees scored rather high on the motivation to 

learn (M = 3.8, on a 5 point scale) and relevance scales (M = 4.0, on a 5 point scale). This 

suggests that overall, trainees were motivated to learn the content being trained (prior to 

completing the course) and found the training content to be relevant to their education 

(after completing the course).  

 A second potential limitation of this study is that, although there this evidence for 

the success for the complexity manipulation, even trainees in the complex conditions (M 

= 1.9, on a 5 point scale) did not report that they found the course overly complex. While 

it is possible that these low ratings may partially reflect trainees’ overconfidence 

immediately following the training course, this may also suggest that the results of this 

study are conservative. It is possible that a more extreme manipulation of training content 

complexity would show more dramatic effects. Likewise a multi-module, time extended 

training course would conceivably demonstrate more substantial effects than observed 

here. Such effects would have important implications for post training performance and 

safety behavior, etc. Additionally, according to CLT, intrinsic complexity is partially 
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determined by the ability and expertise of the learner. Thus, what is complex to one 

trainee may be rather simple for a smarter and/or more experienced trainee. Future 

research should investigate these possibilities. 

 It is also important to mention that overall, trainees performed quite well on the 

declarative and procedural knowledge post course examination (See Figures 1 and 2). 

Although this may lead to some concern that the post course measures was perhaps too 

easy for undergraduate students, some of whom were apparently very familiar with 

PowerPoint prior to taking the training course. It should be noted, however, that the 

declarative and procedural knowledge were operationalized as the percentage of relevant 

items correctly endorsed. Thus, trainees in the simple condition were not expected to be 

prepared for all questions on the test. In terms of raw scores, the number of test items 

correctly endorsed by trainees in the simple condition was significantly lower than those 

in the complex condition. Ultimately, this provides evidence that the training course was 

necessary for trainees’ successful completion of the learning measures. Similarly, the 

“easiness” of several items on the post-course exam may have contributed to the low 

reliabilities observed in the declarative and procedural knowledge. Overall, this suggests 

that the relationships with these learning outcomes in this study were likely attenuated. 

And while attention was paid to the reliability of the criterion measures in this study, a 

cursory review of the most pertinent e-learning and learner control research studies 

reveals that many training researchers apparently do not report/ attend to this 

characteristic of their criterion measures. Training researchers should take greater care in 

reporting these critical characteristics of their criterion measures.  
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Additionally, some cognitive and educational researchers have questioned the 

appropriateness of self-report measures of metacognitive activity (Schraw & Moshman, 

1995; Whitebread et al., 2009). Indeed, researchers have noted the challenges to 

measuring this construct because it is not directly observable (Sperling, Howard, Miller 

& Murphy, 2002). Individual difference measures and “think aloud” measures of 

metacognition do not capture implicit cognitive processing (Whitebread et al., 2009). 

Although Schmidt and Ford’s (2003) measure is commonly used in the  literature, self-

report measures such as the one developed by Schmidt and Ford may suggest activities 

that individuals may or may not have engaged in during training. For example, it is 

possible that a trainee could endorse an item that speaks to a specific metacognitive 

activity but would not have been able to articulate or explain that he/she engaged in such 

an activity without being prompted by a questionnaire. Moreover, while other individual 

difference measures, such as the LGO measure, ask respondents to endorse items that are 

related to their preferences for certain types of achievement environments, which trainees 

are likely cognizant of, higher-order cognitive activities may not be as salient or 

retrievable. In the pilot study, participants were asked to describe the learning strategies 

that they used during the training course. Participants answered this item before they 

completed the metacognitive activity scale. A review of the comments suggests that 

many trainees described very simplistic activities that would not fall under the 

metacognitive or self-regulatory umbrella (e.g., “I just read and reread the material so I 

could familiarize myself with it”, “I mostly looked at illustrations”). In most of these 

cases, participants tended not to endorse many items on the metacognitive activity scale. 

In several other cases, trainees described higher level learning strategies (e.g., “I tried to 
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connect the content on the slides to the learning objectives”, “I determined what content 

on each page I was not proficient with, and focus my time on those things”, “I tried to test 

myself on what I already knew and then focus on things I did not previously know. I 

visualized a real power point and taking each step to create each new learned thing”). As 

expected, trainees who described these types of activities tended to endorse more items 

on the metacognitive activity scale. Nevertheless, the failure of this study to detect the 

established relationship of metacognition mediating the relationship between LGO and 

learning, leads to concerns about the appropriateness of the self-report measurement 

approach used in this study. Alternately it may be that the nature of the particular training 

content, coupled with the fact that it was a one-time occurrence of relatively short 

duration, mitigated against the potentially favorable impact of LGO and accompanying 

metacognitive strategies. Finally, time-on-task was not measured in this study. Thus, any 

differences in time-on-task across the learner control conditions could not be completely 

controlled. As suggested by past research, trainees in learner-controlled environments 

tend to spend less time-on-task compared to trainees in program-controlled training 

environments (Granger & Levine, 2009; Kulik & Kulik, 1991). Nevertheless, Granger 

and Levine (2009) found only limited support for time-on-task as a mediator of the 

interaction between learner control and complexity.   

Conclusions 

Despite the limitations described above, this dissertation provides data that draw 

attention to the criticality of complex training content, a heretofore little researched factor 

in the e-learning literature. When learners are provided with great discretion in handling 

relatively complex cognitive training content their learning suffers. This has both 
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theoretical and practical implications. From a theoretical perspective, the detrimental 

learning outcomes observed in complex, learner-controlled appear to be at least partially 

due to the heavier cognitive demands placed on trainees throughout training. This issue 

can be ameliorated by motivational individual differences, such as LGO, that help 

facilitate learning in these cognitively demanding environments. From a practical 

perspective, these findings offer several important considerations that should be made in 

determining the appropriateness of affording trainees a high degree of discretion in e-

learning. They also offer insight into motivational states that can be induced by trainers 

and instructional designers prior to and during training. Additionally, these study 

suggests that training developers and trainers should not make the mistake of assuming 

that a trainee’s likely greater enjoyment and judgments of greater relevance ascribed to 

training courses when they are given more control of their training will result in better 

learning outcomes. The findings of this study should be extended in future research to 

training whose content is both far more complex than that studied here, and whose 

content focuses on affective outcomes and psychomotor skills. Overall, this research adds 

to our collective understanding of how, when and for whom e-learning is effective, and 

points to critically needed avenues for future research to ensure that the burgeoning 

popularity of e-learning will be of optimum benefit to the diverse populations of learners 

who will use it. 
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Appendix A: Perceived Learner Control Scale 
 

1. Overall, I was in control of the time I spent learning the material in the training 
course 

2. I was in control of the training content that I chose to skip, speed through and 
spend additional time on 

3. I was in control of the sequencing of the training content  

4. I was in control of the pace of my learning 

 
 
 

Appendix B: Perceived Content Complexity Scale 
 

1. Overall, I thought that the training course was difficult 

2. I had no trouble following along with the training material 

3. The large amount of information presented in the training course made it difficult 
for me to learn 

4. The training course was not very complex 
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Appendix C: Familiarity with PowerPoint Scale 
 

1. Opening a blank PowerPoint presentation 

2. Creating multiple slides within a PowerPoint presentation 

3. Inserting text into a PowerPoint presentation 

4. Choosing different visual layouts for a presentation 

5. Choosing different color schemes for a presentation 

6. Inserting pictures and visual aids into a presentation 

7. Identifying and using the Ribbon within PowerPoint 

8. Inserting slide transitions within a slideshow 

9. Using and manipulating SmartArt 

10. Inserting Footers into a PowerPoint presentation 

11. Including Action buttons into a PowerPoint presentation 

12. Utilizing the master slide function  

 
 
 

Appendix D: Cognitive Ability Measure 
 

In the space below, please indicate your highest composite ACT or SAT (verbal + 
quantitative) score and then indicate the test score that you are reporting by checking the 
appropriate box.  If you do not remember your exact score, please estimate to the best of 
your knowledge. 
 
My highest composite score was _________                
      
The scholastic achievement score I am reporting is… 
 
___ACT  
___SAT 
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Appendix E: Declarative and Procedural Knowledge Examination 
 

Instructions: Please select the best answer to each of the following questions.  There are 
a total of 20 Multiple Choice questions in this examination.  There is only one correct 
answer to each question.  You should treat this examination as an actual college-level 
course exam - you may not reopen the PowerPoint training course or use any 
additional tools, such as your mobile device or computer to assist you in answering 
the questions. Your performance on the examination will have no bearing on the number 
of extra credit point you receive. 
 
1). Which of the following includes the three major areas on any PowerPoint page? 
(Choose only one answer) 
 

a). Slide plane, Text box and Title space 
 
b). Slide plane, Notes, and Plane slide view 
 
c). Notes, the Ribbon, and Blank presentation 
 
d). Notes, Home tab, and the Ribbon 
 

2). Which of the following is the correct sequence for moving a text box around a 
PowerPoint page? (Choose only one answer) 
 
 a). Left click inside the text box and use the arrow keys to move the box 
 
 b). Left click on the edge of the text box and drag it to its next location 
 

c). Left click anywhere on the PowerPoint page and drag your cursor across the 
 
d). Right click on the text box that you want to move and follow the instructions 
provided by PowerPoint 

 
3). Which of the following options best describes the purpose of the Ribbon within 
PowerPoint? (Choose only one answer) 
 

a). The Ribbon is PowerPoint’s text box creation center 
 
b). The Ribbon is PowerPoint’s new slide creator 
 
c). The Ribbon is PowerPoint’s Command Center 
 
d). The Ribbon is PowerPoint’s Slide plane view organizer 
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Appendix E: Declarative and Procedural Knowledge Examination (Continued) 
 

4). Which of the following is a common tab located on the Ribbon? (Choose only one 
answer) 
 

a). Slide Organization tab 
 
b). Slide Plane view tab 
 
c). Home tab 
 
d). Advanced Functions tab 

 
 
5). Which of the following represents the easiest way to include text into a 
PowerPoint page? (Choose only one answer) 
 

a). Left click inside a text box and type in the desired text 
 
b). Right click inside a text box and type in the desired text 
 
c). Place your cursor anywhere on the PowerPoint page and type in the desired 
text 
 
d). Left click on the edge of a text box and enter the desired text inside the cursor 

 
 
6). Which of the following represents the easiest way to navigate through many 
slides in a slideshow? (Choose only one answer) 
 

a). Access the Notes area of a PowerPoint page and scroll through slides 
 
b). Access the Slides Tab on the PowerPoint page and scroll through slides 
 
c). Access the View tab on the Ribbon and scroll through slides 
 
d). Access the Home slide and navigate through your slides using the Tab key on 
your keyboard 
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Appendix E: Declarative and Procedural Knowledge Examination (Continued) 
 
7). Which of the following include the correct steps you would take when selecting a 
Theme for your slideshow? (Choose only one answer) 
 

a). Select the Design tab on the Ribbon and left click on a theme you like 
 
b). Select the Home tab on the Ribbon and select New Slide from the dropdown 
menu 
 
c). Select a theme of your choice in the Plane slide view 
 
d). Select the Format tab on the Ribbon and select the Slide view tab from the 
dropdown menu 

 
 

8). Why would you want to include slide transitions into your PowerPoint 
presentation? (Choose only one answer) 
 

a). They allow you to easily navigate through multiple slides 
 
b). They allow you to easily access the Design tab on the Ribbon 
 
c). They allow you to make a presentation flow more smoothly 
 
d). They give you the option to add additional animations to your presentation 

 
 

9). Which of the following is the correct sequence for using the Ribbon to insert 
pictures into your slideshow? (Choose only one answer) 
 

a). Access the Home tab on the Ribbon, move your cursor over the insert option 
of your choice and left click on the insert option 
 
b). Access the View tab on the Ribbon and left click on the slide view tab 
 
c). Access the Insert tab on the Ribbon, move cursor over the insert option of your 
choice, and left click on the insert option 
 
d). Access the Layout tab, move your cursor to the insert option from the 
dropdown menu, and left click on the insert option 
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Appendix E: Declarative and Procedural Knowledge Examination (Continued) 
 

10). Why is it useful to include pictures into a slideshow? (Choose only one answer) 
 

a). Pictures can help keep the audience interested and can complement the text 
you are presenting 
 
b). Pictures can overload your slides and take away from the point you are trying 
to make 
 
c). Pictures allow you to move from slide to slide more smoothly 
 
d). Pictures are useful, but only when they are included in the Clip Art library 

 
 
11). What is the primary difference between custom animation and slide 
transitions? (Choose only one answer) 
 

a). Custom animations make movements from slide to slide smooth, but slide 
transitions do not 
 
b). Custom animations can be applied to individual lines of text or objects but 
slide transitions are usually applied to all slides in the slideshow 
 
c). Custom animations are only available under the Home tab, but slide transitions 
are accessible under most tabs on the Ribbon. 
 
d). Custom animations are always applied to every slide of the slideshow, unlike 
slide transitions. 

 
 
12). What is the primary function of the Slide Master in PowerPoint? (Choose only 
one answer) 
 

a). It allows you to access every tab on the Ribbon quickly 
 
b). It allows you to insert text only into your PowerPoint presentation 
 
c). It allows you to include text or any icons into every slide of your presentation 
 
d). It allows you to use SmartArt for inserting graphics into your presentation 
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Appendix E: Declarative and Procedural Knowledge Examination (Continued) 
 
13). Which of the following is the correct sequence for accessing the Slide Master? 
(Choose only one answer) 
 

a). Select the View tab on the Ribbon and choose the Slide Master option 
 
b). Select the Home tab on the Ribbon, select view from the dropdown menu and 
choose the Slide Master option 
 
c). Right click on the slide plane, select view and choose Slide Master from the 
dropdown menu. 
 
d). Select the Applications tab on the Ribbon and choose the Slide Master option. 

 
 
14). When would you be less likely to use SmartArt in your PowerPoint 
presentation? (Choose only one answer) 
 

a). SmartArt graphics would help enhance the information you are trying to 
present 
 
b). SmartArt graphics would add to the visual appeal of your presentation 
 
c). SmartArt graphics would help your audience better understand complex 
information 
 
d). SmartArt graphics would possibly distract your audience from the main point 

 
 
15). Which of the following is the easiest way to access SmartArt graphics? (Choose 
only one answer) 
 

a). Access the Home tab on the Ribbon, choose the view options and select the 
SmartArt option 
 
b). Create a new slide and select the green arrow out of the six possible icons 
shown in the middle of the slide 
 
c). Create a new slide and select the charts options out of the six possible icons 
shown in the middle of the slide 
 
d). Access the Home tab on the Ribbon and simply select applications which then 
accesses SmartArt 
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Appendix E: Declarative and Procedural Knowledge Examination (Continued) 
 
16). Which of the following represents the correct steps for inserting sounds into 
your presentation? (Choose only one answer) 
 

a). Select the Insert tab on the Ribbon and then click the arrow next to the Sound 
option 
 
b). Select the Home tab on the Ribbon, choose the Insert option and select the 
Sound option 
 
c). Select the Insert tab on the Ribbon and select the multimedia option under the 
Sound dropdown menu 
 
d). Select the View tab and left click on the Applications menu 

 
 
17). Which of the following is not a possible option when including sounds into a 
PowerPoint presentation? (Choose only one answer) 
 

a). Can make sounds within slides start automatically 
 
b). Can insert sounds from both CDs and microphones 
 
c). Can choose the sounds option by selecting the Home tab in the Ribbon 
 
d).  Can choose sounds by accessing the Insert tab on the Ribbon 

 
 
18). Which of the following would not be a common use for a Footer within a 
PowerPoint presentation? (Choose only one answer) 
 

a). Including the date of the presentation on all slides 
 
b). Including an organization or company name on all slides 
 
c). Including the sounds options on the bottom of all slides 
 
d). Including the name of the presenter on all slides 
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Appendix E: Declarative and Procedural Knowledge Examination (Continued) 
 
19). What is the correct way to insert a footer into your slideshow? (Choose only one 
answer) 
 

a). Select the Insert tab on the Ribbon and select the Header and Footer option 
 
b). Right click on a new PowerPoint slides and select the Header and Footer 
option 
 
c). Select the Home tab on the Ribbon, choose the Insert option and select Footers 
from the dropdown menu 
 
d). Create a new slide and select the green arrow from the sex possible icons 
shown in the middle of the slide 

 
 
20). What are the proper steps for saving a PowerPoint presentation? (Choose only 
one answer) 
 

a). Access the View tab on the Ribbon and select the save icon 
 
b). Access the circular window icon at the top left hand corner of the PowerPoint 
screen and select the Save As option from the dropdown menu 
 
c). Move cursor to the circular window icon which is located within the Home tab 
and select the Save option 
 
d). Choose the desktop option from the Home tab on the Ribbon and select Save 
As 
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Appendix F: Skill-based Procedural Knowledge Activity Instructions 
 

Instructions: Please follow the guidelines below to create a new PowerPoint 
presentation from scratch.  Please note that you are not allowed to communicate with 
anyone else in the room during this assessment except for the graduate assistant 
overseeing the study.  Please follow the guidelines below to the best of your ability.  
Your performance on this assessment will have no bearing on the number of extra credit 
points you receive. 
 
 Guidelines 
 
 1). Create a new presentation/ slideshow from scratch using PowerPoint. 
 

2). The content or purpose of your presentation will be how to study for a college-
level course.  For example, you may create a presentation that you would share 
with new college students who are unfamiliar with studying for college-level 
courses. 
 
3). Your presentation should be exactly 3 slides long. 
 
4). Your PowerPoint Skills will be rated on the extent to which you utilized the 
PowerPoint operations taught in the training course.  
 
5). Once you have completed the 3 slide presentation, email the presentation AND 
this completed document to the lead researcher.  

 
 Tips for emailing documents to researcher:  

 Save this completed document and the PowerPoint presentation to your 
desktop 

 Please do not include your name in any of these documents 
 Login to you USF webmail account 
 Email both documents to the researcher 

 
Once you have emailed these documents, you are free to leave the testing room.  
Thank you for your participation in this study!   
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Appendix G: Skill-based Procedural Knowledge Rating Scale 
 

Please rate each presentation based on the creator’s use of the PowerPoint 
operations applied to the presentation (Please refer to the list of trained skills/ 

operations for the appropriate condition) 
 

Note: Do not rate the PowerPoint presentation on the content itself. Rate only on the 
extent to which the creator applied the skills taught in the training course.  

___________ 
 

1 – Very Poor 2 - Poor 3 - Fair 4 - 
Good 

5 - Excellent 

Creator did an extremely 
poor job of 

demonstrating the skills 
trained, in the 
presentation Between 

1 and 3 

Creator did a fair job of 
demonstrating the skills 

trained, in the presentation 

Between 
3 and 5 

Creator did an excellent 
job of demonstrating 

the skills trained, in the 
presentation 

Creator applied few or 
no PowerPoint 

operations taught in the 
training course 

Creator applied several 
PowerPoint operations 
taught in the training 

course  

Creator applied all of 
the PowerPoint 

operations taught in the 
training course 
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Appendix H: Screenshot of Learner-Controlled (LC) Training Course 
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Appendix I: Screenshot of Program-Controlled (PC) Training Course  
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Appendix J: Screenshot from the LC-Simple Training Course 
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Appendix K: Screenshot from the LC-Complex Training Course 
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